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Installation & Configuration Guide

Introduction

Installation and configuration of the SmartPTT PLUS system is a complex task and comprises the following steps:

1. Installation and configuration of SmartPTT Radioserver.

2. SmartPTT Dispatcher installation and configuration.

3. Configuration of MOTOTRBO devices, e.g., radios and repeaters.

4. Configuration of MOTOTRBO tools: MOTOTRBO Network Interface Senice Configuration Utility and
MOTOTRBO DDMS Administrative Client (for networks based on the NAI protocol).

The system configuration depends on the network used and the devices available. In this document, you will learn

how to install and configure the system on the basis of Linked Capacity Plus (LCP) and Connect Plus networks

consisting of 3 sites.

SmartPTT Software Installation

1. After downloading SmartPTT PLUS distribution kit, unpack it to a separate folder.

[=[@][=]
@@vl . ¢ SmartPTT CD Framework d Plus » SmartPTT » - |4’,, | | Search SmantPTT 0o |
Organize « 7 Open Include in library « Share with = Mew folder = « [ @
v Favorites MNarne Date modified Type Size
Bl Desktop . AutoPlay 17.01.201317:34 File folder
4 Downloads L w64 17.01.201317:34 File folder
5 Recent Places ) autorun.exe 13.09.2006 9:32 Application 2344 KB
4k | autorun.inf 07.10.200913:20 Setup Information 1KB
s Libraries 7] SmartPTT Installation Guide.pdf 0512.2012 10:47 PDF File 61 KB
@ Documents

2. Run autorun.exe.
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3. Install SmartPTT Radioserver first and then SmartPTT Dispatcher. For both installation processes the setup

wizard will be used.

InstallShield Wizard

Preparing to Install...

Installshield wizard Setup is preparing the InstallShield
‘Wizard, which will guide vou through the program setup
process, Please wait,

Extracting: SmartPTT Plus Radioserver.msi

[-l- ]

Cancel
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SmartPTT Software Installation

4. Follow the steps of the setup wizard.

Note: When installing SmartPTT Radioserver, please remember that Microsoft SQL Server is used by SmartPTT

Radioserver to log network events. This feature is optional and turned off by default.

i'-.% SmartPTT Plus Radioserver - InstallShield Wizard

Custom Setup

Select the program features vou wank installed,

Click on an icon in the lisk below o change how a Feature is installed.

SmartPTT Ra or Feature Description

SQL20038 Express
Remoke Assistance

This Feature requires 37ME on
wour hard drive.

Install ko
C:\Program Files\,SmartPTTiServer)
Inskallshield

[ Help l [ Space ] [ < Back l[ et = ] [ Cancel ]
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SmartPTT Software Installation 5

Note: When installing SmartPTT Dispatcher, make sure you have SQL Server installed. If not, install SQL

Express together with the dispatcher console.

i SmartPTT Plus Dispatcher. - InstallShield Wizard

Custom Setup

Select the program Features you want installed,

Click on an icon in the lisk below ko change how a Feature is installed.

Feature Description

SmarkPTT Dispakcher
=~ | SQL2008 Express
= ~ | Remote Assistance

This feature requires 118MBE on
vour hard drive,

Install tao:

C:\Program FilesiSmartPTT\Client Test),

[ Help ] [ Space ] [ < Back “ Mext = ] [ Cancel ]

5. Once you hawe finished, close the installation window.

General SmartPTT Radioserver Configuration

General configuration includes parameters that are independent of the network type. To configure the general

settings of the radioserver open SmartPTT Radioserver Configurator.
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General SmartPTT Radioserver Configuration

1. Set up parameters of the radioserver.

# SmartPTT Server Configuration - C:\Program Files\SmartPT \Server\RadioService.exe.config

Settings |F|u|es || td anitoring || Client List || Log || E xport/Import Settings || Statistics|
SR Fadio Server

Radio Server
. f{’ Radio Metwork, Services
Add-on Modules Mame
“'r: Control Stations |F|au:|insewer |
. ﬁ Connect Plus
----- H Radio Activity Networks Interface Part
o g M Networks 1192168.37.13 v | |a8as ]
: B9 SmartPTT Radioservers
. -ﬂ, Profiles Authentication
: f‘_‘j. Subszcriber Groups |Nn:| v|
h tultiGroups
. {)d Metadata Encryption
WalP Lizten Paort
Black Options (Kill Radic |

Redundant Server Settings

Server Role | Primary “ |

Elorgﬁgloi']ewm Address | rernotehost 3888 |

Connection Timeout, sec

Limit Badios to Service

[] Enabled Ewarnple: 1-39,150

Allowed A adio Mumbers

Language English

(D] [ [ sewice: Stopped Plus 8.4.0 12160 ‘@“E@‘ ‘ﬁ‘

¢ In the Name field specify the radioserver name. This name is used only in SmartPTT Radioserver

Configurator;

¢ In the Interface field and the Port field specify the IP address and port of the PC where the radioserver is

installed.

2. Enable radio network senvices, e.g., ARS, GPS and TMS support.
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General SmartPTT Radioserver Configuration

e To enable ARS support, select the Active check box under ARS:

=--E% Radio Server ARS
EI# Radio Network Services
..... ARS Active
Q GPS
..... 58 TMS Radio Inactivity Timeout, = 600
----- (s Telemetry
""" ?’ Subscriber Blacklist Global Minimum Request Interval, ms 1000
B-f-=] Email Gateway
4 SMS Gatew
b = Use Radio Check
e To enable GPS support, select the Active check box under GPS:
=-E% Radio Server GPS
£ Radio Network Services
..... ARS Active
Rlces
_____ 7 TMS Minimum location update interval, s 60
----- Iz Telemetry
----- ?) Subscriber Blacklist Minimum Request Interval, s 1
-] Email Gateway
[ SMS Gateway ) -
_____ # Fie Receive Radio Inactivity Timeout, = 60
-4 | Add-on Modules
_____ { . Cortrol Stations Get Subscrber Location for Following Groups:
Connect Plus
Radio Activity Networks Group Mame Time Interval, s QA0

-y MAI Metworles

..... FN SmartPTT Radioservers
.m Profiles

..... zé, Subscrber Groups

----- u MultiGroups

Ea..tﬂ Metadata

e To enable text messaging senvice, select the Active check box under TMS:

=-#% Radio Server
=4 Radio Network Services
P ARS

SmartPTT PLUS 9.0
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SmartPTT Dispatcher Configuration 8

SmartPTT Dispatcher Configuration

In this topic you will learn how to configure general settings of the SmartPTT Dispatcher console. The general

configuration in the scope of the LCP or Connect Plus network implies that operators will be able to communicate

with radio subscribers and the radio subscribers will be able to communicate with each other.

The general configuration of the SmartPTT Dispatcher console includes the following steps:

1. License installation

2. Database creation

3. Radioserver configuration

4. Audio setting configuration

5. Registration of radio subscribers

The description of the steps is given below:

1. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click Licenses.
Install the required license. After uploading the license, click Finish to apply.

2. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click Database. In
the opened window create the new database and then connect to it.

To create a new database, fill in the Database Server Name and click Create New Database. For a database

server installed together with the SmartPTT dispatcher application enter the name using the format: Name of PC

\SQLExpress (for example, MYCOMP\SQLExpress).

In the window that opened enter the name of the new database and click Save.

SmartPTT PLUS 9.0 Installation & Configuration Guide



SmartPTT Dispatcher Configuration

|Comfigueation X

Database

Settings for connection to M5 SQL Server database

SmeartPTT

Database server name | localhost\SQLExpress

For database server installed locally at SmartPTT Dispatcher PC enter name in the fellowing
way: Name of Computen\5QLExpress (e.g., MYCOMMSQLExpress).

Account name

Password

Authorization mode 'medows TR

Create Mew Database l

Database Mame

£2

Restore from File

New Databasel

Save ] [ Cancel

Cancel | [ Finish

If creation was successful, a message about successful database creation is displayed. If the database is not

created, the reason will be displayed at the bottom of the window.

Authorization Mode — allows you to select authorization mode with the database.

SQL Server Authorization — you must have the login and password of the account which has access to the

SQL senrver.

Windows NT Authorization — the user who has logged into the Windows system, must be listed in the SQL

sener’s list of users to make connection.

After you have finished, click Finish to save the changes. You will need to restart SmartPTT Dispatcher to apply

SmartPTT PLUS 9.0
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SmartPTT Dispatcher Configuration

10

the changes.

3. In the Settings menu click Radioservers to add the radioserver and configure it properly.

Radioservers

Radioservers controlled by Dispatcher Console

SmeartPTT )

4+ add  # Edit = Delete

Server Name | Address

Login Active -~

Click Add to open the window for adding radioservers to the list.

Server Settings
General
Active
Mame |Radioserver
Address | 192.168.37.13 Port | B8B83
Proxy Proxy Port
Login
Password
Operator | Profile Mame | -
Administrator [ | v]
-
OK || Cancel
L~ A

SmartPTT PLUS 9.0
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SmartPTT Dispatcher Configuration 11

Enter the name of the radioserver in the Name field. The name will be displayed in the SmartPTT Dispatcher

console.

In the Address and Port fields enter the radioserver IP address and port number to connect with the dispatcher.

To find out the radioserver IP run the ipconfig command on the PC where the radiosenver is installed. The default

radioserver port number is 8888.

Select the Active check box to enable the radioserver.

For more information about the radioserver settings see Help in the SmartPTT Dispatcher application.

4. Audio setting configuration is required to give the operator the ability to communicate with the radio
subscribers. Expand the Settings menu in the Main Menu bar of the SmartPTT Dispatcher window and click

Sound.

Sound Settings

Auvdio devices and VolP settings 5' ' 'dr‘-p I l

General Settings | Audio Output Devices | Other Settings |

— Audio Input
Device | microphone (2- USB audio CODEC) v |
Input Line [Audio | v]
Noise Reduction :[,}jsabled )
AudioInputTest | Record.| | Check ||  save |
— Audio Output

Device [Deﬁ,un | v] Check

—VaolP Parameters

Codec [ CCITT u-Law | v]

Codec Format [ 2000 Hz. 20 ms. 64 (36) kbos | - ]

VoIP Port | 18501

Cancel | [ Finish

. oy
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SmartPTT Dispatcher Configuration 12

Audio Input — audio device to which the microphone is connected.

Input Line — audio mixer line used to connect a microphone.

Audio Output — audio device to which headsets or speakers are connected.
Codec — audio stream compression method.

Bitrate — audio stream sampling frequency.

VolIP Port — audio stream receive port.

Specifications of the codec format 8000 Hz, 20 ms, 64 (86) kbps:

8000Hz — the sampling rate.

20 ms — the frame size.

64 kbps — the wice data bit rate.

86 kbps — a full bit rate (required network bandwidth).

For more information see Help in the SmartPTT Dispatcher application.

5. Register radio subscribers. Unregistered radio subscribers are displayed in italics in the Radio Fleet window

and are not recorded into the database.

- @ Radioserver - 55
- m Slot1 PTT »

Y ——
[ (8 120022 ) [ ( Empty ) PTT »
- o Slot2 PTT »
H Paul L] (Empty ) FTT >»

SmartPTT PLUS 9.0 Installation & Configuration Guide



SmartPTT Dispatcher Configuration 13

To register the radio subscriber, right-click on the radio subscriber, enter the name and click Save.

General Location | Custom

P 120022 |
MDcID|  |STonem| |
Name | Mike |

[select | [x] Status [iempty =]
] [ 4]~

Lone Worker [Securitl_.-' | - ]

| sae | [ cancel |

Connect Plus

SmartPTT PLUS supports Connect Plus multi-site trunking system, which starting from version 8.5 can be used
not only for Presence Notification senice, TMS and GPS functionality, but also for voice communication between
the dispatcher and radio subscribers.

Connect Plus network can include up to 15 repeaters (29 channels + 1 control channel) on each site. Each site
must have at least one XRC Controller. It is the core of the Connect Plus network and its presence on each site is
obligatory. The XRC Controller provides central call processing and real-time resource management for
MOTOTRBO Connect Plus digital trunking systems. There can be two XRC Controllers per site if one of them
serves as backup to the primary XRC. The secondary controller provides backup capability, but it does not
increase the number of repeaters and calls that can be managed per site.

XRT Gateways are required for voice communication and call event monitoring.

You can also build the Connect Plus system based on control stations for voice communication instead of the
XRT Gateway. In this case, the XRC Controller is not mandatory either. But without the XRC Controller you won't
be able to transfer data (GPS, Presence Notification, TMS). For more information on how to configure control

stations instead of the XRT Gateway for voice communication see MOTOTRBO Control Stations.

MOTOTRBO Connect Plus multi-site trunking network provides extended load capacity and provides digital

communication to as many as 2,900 users per site.

SmartPTT PLUS 9.0 Installation & Configuration Guide



Connect Plus 14

For more information about the XRC Controller and XRT Gateway see MOTOTRBO Connect Plus System Planner.
The Connect Plus network configuration includes the following stages:

1. Setting up MOTOTRBO equipment configuration parameters: XRT Gateway, XRC Controllers, repeaters,

control stations (which are to be used instead of the XRT Gateway), and radios.

2. Setting up SmartPTT Radioserver parameters to operate with Connect Plus network.
The goal of this document is to help system administrators configure SmartPTT Radioserver parameters to
operate in the Connect Plus network. The document contains detailed information on SmartPTT Radioserver
settings, specific to this network type, XRC Controller and XRT Gateway settings that are necessary for the
operation with SmartPTT Radioserver, and some settings of MOTOTRBO radios, which we think must be covered.
Also, the document contains information on the configuration of control stations which can be used for wice calls
instead of the XRT Gateway. For detailed description of MOTOTRBO equipment settings see MOTOTRBO

Connect Plus System Planner.

MOTOTRBO Equipment Programming

To program MOTOTRBO equipment you will need special MOTOTRBO configuraton software:
e MOTOTRBO Customer Programming Software (CPS)
e MOTOTRBO Connect Plus XRC Network Manager for XRC Controller configuration
e MOTOTRBO Connect Plus XRT Network Manager for XRT Gateway configuration

¢ MOTOTRBO Connect Plus Option Board CPS for radio option board configuration

Note: Make sure you that firmware versions for all MOTOTRBO equipment used in one network are compatible.

SmartPTT PLUS 9.0 Installation & Configuration Guide
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MOTOTRBO XRC Controller and XRT Gateway

The scheme below shows the sample of Connect Plus network.

IP network —.7

R

B
SmartPTT SmartPTT
Radioserver Dispatcher
P IF — E—
Site 3 \

Site 1 \

] IP network \I
[]
P P )
Repeater ID=1 P Repeater D=1
—T= . B /
Repeater D=2 Site 2 4 Repeater D=2

IP Repeater ID=1 |,'I

Repeater D=2
*,
Y

Repeater D=3 /
\ P

'\-\_\_\_\__'_'_,_o-""

In this network there is only one XRT Gateway in the network system, and one XRC Controller per site. The
number of repeaters per site can be different. In this case there are two and three repeaters on site.

The XRT Gateway joins the MOTOTRBO Connect Plus system as another multi-site XRC Controller peer. It
creates a pathway between the radios on a Connect Plus system and the third party application, in our case it is
SmartPTT Radioserver.

The XRC Controller controls up to 15 MOTOTRBO repeaters per trunked site. Because this is an IP interface, the
XRC Controller and its connected repeaters could theoretically be in different locations. However, due to the time

sensitive nature of the messaging between the controller and the repeaters, the XRC Controller and its trunked

SmartPTT PLUS 9.0 Installation & Configuration Guide
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repeaters must be at the same physical location and connected to the same Ethernet switch. The XRC Controller

can control up to 30 digital channels (timeslots) per Connect Plus site. One of these timeslots must be dedicated

for Control Channel signaling. All other timeslots are used by the controller for call assignment.

In this article we will focus mainly on the most critical parameters of the XRC Controller and XRT Gateway, which

are required for operation with SmartPTT Radioserver. Other information on the XRC Controller configuration can be

found in MOTOTRBO Connect Plus System Planner.

1. In our example we have a multisite networking, therefore each XRC Controller must be enabled for multi-site
operation.

2. Make sure the Pool IDs field in SmartPTT Radioserver Configurator matches the Pool ID field in XRT Gateway

settings.
Settings ‘ Rules | Monitaring | Client List | Netwark Configuration | Log Expoit/Import Settings | Statistics Site Confi
= 9 Radio Server XRT Gateway Configuration
£# Radio Metwork Servces =
o o Modules e Critical Settings =
. Control Stations M ‘XHT |
= ame
4 C t Pl
& h ennect s WwWARMING: Changes to this zection will require a reboot of
= h Connect Plus 1 ) wBT 9000
0 475 XRC Contraller Gateway AddiessPort | 192.168.7.122:10001 | :
=] h ﬁ![ﬁ{?;:(le‘l ‘ ‘ Site Configuration
alkgroups Pool IDz 16000001-16000070 | .
5 h AC_Site 2 - Local Site ID 255
82 Takaoups Cornect Plus Network 10 238
g h RC_Site 3 Usemame ‘usemamzﬂ \ ‘
™ XH% Talkgroups \ MNetwork Configuration
= REJ - steways Password |passwn|d1 \ | Multizite UDP Start Port 45000
Talk Paths Max Multisite Ports a2
g’ Radio Activity Metworks o =
H Ml Metworks Multisite: Pirg |nt 2800 ms. 5
5 gm‘?‘rtPTT Fadioservers T Time-Out Timer, sec Multisite Control Fort 45000
1ofiles
&5 Subscriber Goups Group Call Hang Time, ms 4000 E Client TCP Port 10001
,& MultiGroups )
il Metadsata Frivate Call Hang Time, ms E000 E Client UDP Start Port Frn
N
Emergency Call Hang Time, mz 2000 3 NTP Configuration
] NTP Server
MTP Server Addiess
MNTP Update Interval E0000 ms.
Paool ID Configuration i
Pool ID 160000071-16000010
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3. Make sure that there is a user record for every pool ID in XRC Controller configuration:

Disconnect  Site Dashboard (Open)  Settings  Site Control  Real Tirne Display  Metwork  AlertsfAlarms  Logs  Windows  User  Group  Multigroup  Help

m ﬁ m n|)< |§ﬁ|$earch|:|(:|ear

Fecord Type |] Friority Statuz Serial Mumber Multigroup 1D Mates
Enabled
User 102 Disp 102 g Enabled 037TMLva01 1000
User 2m 20 g Enabled 037THMLY 348 1000
User 202 202 g Enabled O37THLY343 1000
User 403 403 g Enabled 037THMT 1829 1000
User 16000001 HRTClient g Enabled 1000
User 16000002 HRTClient g Enabled 1000
User 16000003 HRTClient g Enabled 1000
User 16000004 HRTClient g Enabled 1000
User 16000005 HRTClient g Enabled 1000
User 16000006 HRTClient g Enabled 1000
Uzer 16000007 HRTClient g Enabled 1000
User 16000008 HRTClient g Enabled 1000
User 16000003 ARTClient g Enabled 1000
User 16000010 HRTClient g Enabled 1000
Group 100 Group 1 g Enabled
Group 1002 Group 2 8 Enabled
Group 1003 Group 3 g Enabled
bultigroup 1000 1000 8 Enabled

4. Check user restrictions under XRT User Configurations in MOTOTRBO Connect Plus XRT Configuration Tool:

Disconnect  Settings  Site Contral  Metwork  Logs  Windows  Help

Username taw Talk Pathe  Biling Enable MWt Enable Data Path R... Group Talk Paths Private Talk Pathz User Details

Usemame

Pazsword

Canfirn Password
Max Talk Paths 10
Billing Enabled
Metwork YWwide All Call [M'wAC) Enabled
Data Path Registration Enabled
Group T alk Paths
[ Group 1D 10001003 |

Private Talk Paths

Cansole User D m |

Save -Delete

e Check that the Username and Password match Username and Password in SmartPTT Radioserver

Configurator in XRT Gateway settings.

SmartPTT PLUS 9.0 Installation & Configuration Guide
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e Check the Group ID. The values in the field must match the IDs used for group calls in SmartPTT

Radioserver Configurator in XRT Gateway talk path settings. If the field is empty, the user should have

permission for any Group Talk Path that it validly registers with the XRT 9000. If any Group ID is entered,

then all Group IDs not configured into this field will be disallowed!

e Check Console User ID. It should match Radio ID in SmartPTT Radioserver Configurator.

Settings | Rules | Activity | Ciient List | Log

| Export/Import Settings | Statistics |

=8 Radio Server
i -§#* Radio Network Services
Add-on Modules
...... "E: Control Stations
----- w IP Site Connect Metworks
..... iy Capacity Plus Systems
|_—_| ﬁ Connect Plus
= h- Cannect Plus 1
; Securty Settings
+ ¥RC Controllers
----- ,,._..¢ ¥RT Gateways
g Radio Activity Netwarks
gy NAI Networks
H SIP/RTP Interfaces
..... FN SmartPTT Radioservers
-k Profiles
..... & Subscriber Groups
----- a MuliGroups

-l Metadata

Connect Plus

Active

Mame Connect Plus 1

Metworc 1D 1

Peer ID 1

Radio ID 101

Irterface 152.168.37.170 -
UDP Start Port 15000 =

If the field is empty, the user should have permission for any Private Talk Path that is validly registered with

the XRT 9000. If any Private Talk Path ID is entered, then all other Private Talk path IDs will be disallowed.

MOTOTRBO Control Stations

This topic will be interesting to those who want to build the Connect Plus system based on control stations

instead of the XRT Gateway.

Starting from version 8.7 it is possible to build the Connect Plus system based on control stations. With the use

of control stations, the XRC Controllers and the XRT Gateway become optional. Note, that this is true only for

SmartPTT Enterprise.

There are two supported network topologies with control stations (i.e. without the XRT Gateway):

1. With the use of control stations and the XRC Controller. In this case the system will have the following

characteristics and restrictions:
o Data transfer

o Presence Notification senice

SmartPTT PLUS 9.0
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o One control station per talkgroup
o One control station per dispatcher for private calls and CSBK commands
2. With the use of control stations only. In this case the system will have the following characteristics and
restrictions:

o No data transfer

o No Presence Notification sence, i.e. the radio subscriber goes online only after some activity (e.g.,
making a call), and never goes offline. Checking radio's presence in the network will be possible only
through the Radio Check command.

o One control station per talkgroup

o One control station per dispatcher for private calls and CSBK commands

Note: One control station can be used for both private calls and group calls. However, if a call to the talkgroup is

initiated during the ongoing private call, the call to the talkgroup will be missed.

The minimum system requirements are:

e Connect Plus system v1.5 or later

e SmartPTT Enterprise 8.7 or later

e SmartPTT Mobile Client 8.7 or later (only Android OS). The mobile client will work properly only in network
systems based on control stations (without the XRT Gateway), and won't support All Call.

¢ Special license for control stations in Connect Plus and a license for mobile clients (wice and data)

¢ Control stations with firmware 2.4 or later

e USB cables to connect control stations to the PC with the radioserver

e Empty USB port

Key points of the control stations' configuration

Here you can find information on the key points of the configuration of control stations. For more information on

MOTOTRBO radio programming for the Connect Plus environment see MOTOTRBO documentation (MOTOTRBO

Connect Plus Multi-Site Digital Trunking System Planner).

To configure control stations, use the special tool, MOTOTRBO Connect Plus Option Board CPS.

1. In the Connect Plus systems, after the control station is connected to the radioserver, you can't change the
channel on the control station. So if you want to use the control station for group calls, it is important to assign

it to a channel with a unique registration group (Connect Plus Option Board > Zones > Channel

SmartPTT PLUS 9.0 Installation & Configuration Guide
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Selections). The ID of this group will be used in the radioserver's settings, in SmartPTT Radioserver
Configurator.

& MOTOTREO™ Connect Plus Option Board CPS - Version R01.41.012 = e |

File Edit View Device

Codeplug Frequency

Help  DM3600_DM3601_VHF_Index8.cno

| General Zone Parameters I Zone Contacts | Zone Channel Selections | Zone Emergency | Zone Scan|

= Connect Plus Option Board
- General Settings

- Aocessories

- Buttons

- Teat Messages

- Menu

- Zones

B Zonel

|- Contacts

[#- Networks

Zone1 Channel Selections

Registration Group

»

Position Contact Name Contact ID Moo Registration 1D R Only Privacy Key—
7 1001 Group 1001 1001 O 1
. 1
» :
. :
p 1

m

2. If you want to use the control station for private calls, dedicate a special group for private calls. Make sure that

there can be no group calls addressed to it. If you have more than one dispatcher, use this registration group for

all control stations reserved for private calls. Also, under Menu > Contacts select Manual Dial and other

CSBK commands.

File  Edit View Device

Codeplug | Frequency

&' MOTOTRBO™ Connect Plus Option Board CPS - Version R01.41.012

Help DM3600_DM3601_VHF_Indexd.cno

=)

= Connect Plus Option Board
- General Settings
- Accessories
- Buttons
- Text Messages
- Zones
B Zonel
- Contacts
Group 1001
Channel Selections

(- Networles

Menu
Menu Hang Time 10
Text Message

5 seconds

Contacts

Call Mert Radio Check

Edit Remote Monitor
Radic Enable

Radic Disable

EEE

Manual Dial

EEEE

Scan
Scan

»

So, if you have several talkgroups (let's say three) and one dispatcher, you will need three control stations for

group calls (each control station must be reserved for a talkgroup), and one for private calls of the operator. If you

have more than one dispatcher, you will need an additional control station per dispatcher. Use the same

registration group for all control stations reserved for private calls.

After you hawe finished configuring the control stations, make the necessary settings in SmartPTT Radioserver

Configurator (see here).

SmartPTT PLUS 9.0
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MOTOTRBO Radio Programming

In this article we will focus on the radio settings critical for communication between the radio and SmartPTT
Dispatcher. Other information on MOTOTRBO radio programming for the Connect Plus environment can be found
in MOTOTRBO documentation (MOTOTRBO Connect Plus Multi-Site Digital Trunking System Planner).

As was stated before, radio programming for the Connect Plus environment requires special software:
MOTOTRBO Connect Plus Option Board CPS.

To allow radio subscribers to send messages to the dispatcher, add special contact of the Dispatch Call type:

&L MOTOTRBO™ Connect Plus Option Board CPS - Version R01.41.012
File  Edit ‘iew Device Help DP4400_DP4401 VHF Index2i.cno

Codeplug | Frequency General Zone Parameters | £one Contacts | Zone Channel Selections I Zone Emergency | Zaone Scan
=) Connect Plus Option Board Z 0ne1 C OntaCtS

- General Settings
- Buttong

- Tedt Meszages
- Woice Announcement Mult Group Cal
= Zones

B Zanel P
- Contacts Dispatehe Dispatch Cal
¢ b Multi Group Call
-Call

E Chatinel Selections

Contact Mame Call Type Call D

tultigroup Call 1000

»

m -

[ Metwarks

Note: Remember to add contacts of Dispatch Call for all dispatchers (if you have more than one) and specify

their unique IDs, which are specified in SmartPTT Radioserver Configurator under Profiles.

SmartPTT Radioserver Configuration

In this topic you will find description for two system topologies: Connect Plus based on the XRT Gateway, and

Connect Plus with control stations.

Connect Plus with the XRT Gateway
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The configuration process includes the following steps:
1. Run SmartPTT Radioserver Configurator, which you have downloaded and installed, as described in SmartPTT

Software Installation.

2. Make sure you have the necessary licenses to work in Connect Plus network, i.e., Connect Plus Voice Support

and Connect Plus Data Support.

Settings

=-#8 Radio Server
[-£# Radio Network Services

Available Licenses

B+ Add-on Modules SmaiPTT Demo
""" :?l Update Subscription Expiration Date: 123172014
----- B Talysman
..... H Indoar Tmcking License KE-'}’ 1D 7eR36CD3
[ Event Log : -
=-{[F] Telephone Interconnect License o L -
..... Bridging Indoor Tracking 1 124312014
""" wg Voice Notifications Connect Plus Voice Support 1 12/31/2014
----- @ VV=b Application
EEI--H Menitoring Connect Plus Data Support 1 1243172014
o B SNMP Service NAI Voice for IP Site Connect 5 12/31/2014 |2
----- %> Control Stations 1
E:I--g Connect Plus MAI Voice for Capacity Plus L 124312014
i Radio Activity Networks NAI Vaice for Linked Capacity Plus 5 12/31/2014
H MAI Metworks
..... B SmartPTT Radioservers GPS Positioning 1 123172004
ﬂ Prafiles - " - 4 e s i
----- &5 Subserber Groups
..... 42 MuttiGroups Install Licenses ‘
{3l Metadata
Activation
Hardware |D
Collect

3. In the setting tree on the left, right-click Connect Plus, select Add, and then Connect Plus.

Connect Plus

Connect Plus
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At that, the Connect Plus window opens.

Settings | Rules | Activity | Client List | Log | Export/Import Settings | Statistics |
=2 ;d"’ Server Connect Plus

[ Radio Metwor Services )

-4 .\ Add-on Modules Active
----- %\_} Control Stations
g |P Site Connect Networks Name Connect Plus 1
g Capacity Plus Systems

[—]H Connect Flus Network |D 1

(=¥ ™1 Connect Plus 1 PeerID 1
i..J2h Security Settings
¥RC Controllers Radio ID 1M
7 XRT Gateways
E Interf; 152.168.37.170 -

4 Radio Activity Networks e
- H MAI Networks =
—iag SIP/RTP Intedaces UDP Start Port L
----- B9 SmartPTT Radioservers
ﬁ Profiles
----- & Subscriber Groups
----- a MultiGroups

[3--@ Metadata

4. Set parameters:

Select Active to enable the Connect Plus network.

In the Name field enter the name of the network.

In the Network ID field enter the unique ID of the Connect Plus network, which is used inside SmartPTT.
This is important if you have more than one Connect Plus network. In our case there is only one network,
so we leave the default value. Note that this ID is different from the Network ID defined in the XRC Controller
codeplug.

In the Peer ID field enter unique ID of the virtual repeater (i.e., radioserver in Connect Plus network). This
parameter is used only for wice packets to the XRT Gateway, so leave the default value. Make sure this ID
is different from the repeater ID in the Connect Plus network.

In the Radio ID field specify the ID of the virtual control station by default, the parameter is used to
represent the radioserver inside Connect Plus network, therefore, this ID will be used for the dispatcher. It
is used for data and wice transmission. Make sure it is not duplicated to any of the radio ID in the
system.

In the Interface field specify the IP address of the virtual repeater (i.e., SmartPTT Radioserver).

In the UDP Start Port specify the first local UDP port available for XRT Gateway talk paths. Each talk path
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requires one local UDP port. Next talk path will use UDP Start Port incremented by 1, and so on.

Note: If you have more than one dispatcher in the system, you should specify the unique ID for all

dispatchers. To do it, create a profile per dispatcher and specify the unique ID:

Settings

=8 Radio Server

(-4 Radio Network Services
(-4 .. Add-on Modules

..... !;.\ Control Stations

- H Connect Flus

iy Radio Activity Networks
g MAI Networks

----- FN SmantPTT Radioservers
=4, Profiles

"

..... t’é Subscriber Groups
..... h MultiGroups
EB--t'j] Metadata

Profile
MName Profile 1

----- | Alowed Radios: Mot set
EI ¥ |Connect Plus 1
| ¥ Graup 2
[ ] Group 4
-] Group 1
[ Group 3
[ All Calls
= .Hadlo MNetwork Services

5. There are three sites in our network, and each contains one XRC Controller. It is not necessary to add all the

three XRC Controllers in SmartPTT Radioserver Configurator. It is required only for monitoring purposes. If you

do not want to monitor all XRC Controllers, you can add only one. To add an XRC Controller, right-click XRC

Controller and select Add:

=98 Radio Server
-5 Radio Network Services
Add-on Modules
l‘.-: Control Stations
El ﬁ Connect Plus
' =- h Cunnec:t Plus 1
------ 4 Securty Seftings

..... ﬁ *RT Gateways

Add

----- g Hadm Activity Metworls
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6. Specify parameters for the XRC Controller:

Settings

25

[=-#% Radio Server
# Radio Network Services
-4 | Add-on Modules
‘E Control Stations
B--g Connect Plus
Elh- Connect Plus 1
----- 2t Secunty Settings

-5 XRC Controllers

R Talkgroups
Lo XRT Gateways
-y Radio Activity Networks
g MAI Networks

----- B9 SmatPTT Radioservers
-ﬁ Profiles

----- 4"‘_"_5. Subscriber Groups

----- &3 MuttiGroups

E-{g8 Metadata

XRC Controller
Active
Mame

Controller
Address

PN, TMS, GPS
PM
Controller Part

Local Port

TMS
Cortroller Port

Local Port

GPS
Controller Port

Local Port

Manitoring
Controller Part

Local Port
Use NAT

e Select Active to enable XRC Controller support.

XRC Controller Site1

192.168.7.23

¢ In the Name field enter the XRC Controller name. This is used only in SmartPTT Radioserver Configurator.

¢ In the Controller Address field specify the IP address of the XRC Controller. Port is not required in this

field.

e Select the PN, TMS, GPS check box to enable data senices. Specify Controller port and Local port for

each senvice, where Controller port is the XRC Controller port and Local port is the virtual repeater port.

You can leave default values. Local PN, TMS and GPS ports should not be in conflict with other local ports

used for other purposes used on this PC.

Note: The PN, TMS and GPS senices can be set only for one of the XRC Controllers in the network. These

settings will be used by other controllers available in the network.
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Note: The PN, GPS and TMS ports should match the same ports in MOTOTRBO Connect Plus XRC

Configuration Tool.

e Select Monitoring check box to be able to review the XRC Controller on the Monitoring panel in
SmartPTT Dispatcher. Specify Controller port and Local port. The Monitoring senice is enabled on all
existing XRC Controllers. You can leave default values. If the XRC Controller is in one local network with
the radioserver, leave Use NAT unchecked. If the XRC Controller is outside the local network of the

radioserver, select Use NAT.
Note: Make sure that you have the general Monitoring senice enabled (SmartPTT Radioserver Configurator
> Add-on Modules > Monitoring).
If needed for monitoring purposes, set parameters for the other XRC Controllers, but remember to leave the

PN, TMS, GPS check box unchecked.

8. Add an XRT Gateway by right-clicking on XRT Gateways and selecting Add.

=-#% Radio Server

i £ Radio Network Services

Add-on Modules

...... l“r‘-\ Control Stations

|_—_| ﬁ Connect Plus
=- h Cnnnec:t Plus 1

i.tgk Security Settings
% ¥RC Controllers

=

E....@
iy Padio Activity Network Add

- MAI Networks
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At that, the XRT Gateway window opens:

Settings
E‘E Radio Server XRT Gateway
-4 Radio Network Services
!;"" Add-on Modules
%> Control Stations Mame ¥RT Gateway
|_:_|Hr Connect Plus
E‘h‘ Connect Plus 1 ) -
T4 Security Seftings Gateway Address:Port 152 168.7 12210001
[0 XRC Controllers
5{5} ¥RT Gateways Pool 1Ds 1RO00001-160001 00
E-huy
(- Talk Paths
L aritest
4ag Radio Activity Networks semame EELsE
H MAl Metworlks
----- B9 SmartFTT Radioservers Password pasw 1
|§:|--jﬁ¢I Profiles
----- &5 Subscriber Groups
----- h MultiGroups
B[] Metadata
TX Time-Out Timer, s G0 =
Group Call Hang Time, ms 4000 =
Private Call Hang Time, ms GO0 =
Emergency Call Hang Time, ms 2000 =

9. Specify parameters of the XRT Gateway.
e Select Active to enable XRT Gateway support.
¢ In the Name field enter the XRT Gateway name, which is used only in SmartPTT Radioserver Configurator.
¢ In the Gateway Address:Port field enter the IP address and port of the XRT Gateway.

¢ In the Pool IDs field use default values. The values must correspond to the range of IDs set in the XRT

Gateway settings (Pool ID):
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Setlings ‘ Rules || anitaring || Client List || Metwark Configuration ” Log ” Expoit/Import Settings || 5tatist\cs|

Site Confis

(= B8 Radio Server
=] # Radio Metwork Services
Add-on Modules

“:\ Cantrol Stations

=- g Connect Plus

=8 h Connect Plus 1

=% ®AC Cortroller

g <RC_Site 1

a Talkgroups

g #RC_Site 2
h Talkgroups

== h #RC_Site 3

: a Talkgraups

El r"'\ #RT Gateways
™

Talk Paths
CI"W Radio Activity Metworks
g NAI Netwarks

B0 SmartPTT Radioservers
,ﬂ Profiles

&5 Subscriber Gioups

h MultiGroups

- Metadata

XRT Gateway
Aictive

Mame AT

Gateway Address:Port ‘192.158.?.122 10001

Pool IDs | 16000001-16000010 | |
LY

Uzermarne ‘ userharne \ ‘

Password |passwn|d‘l \ |

T Time-Out Timer, sec

Group Call Hang Time, ms
Private Call Hang Time, mz

Emergency Call Hang Time, mz

TS
o .

Configuration

28

Critical Settings

WwWARMIMG: Changes to this section will require a reboot of

#RT 3000,

Site Configuration
Local Site 1D

Connect Plus Network 1D

Netwark Canfiguration
Multisite UDP Start Port

M ax Mulisite Ports
tultizite Fing Int
Multizite Contral Part
Client TCP Part
Client UDP Start Part

NTP Configuration
] NTP Server

MNTP Server Addiess

MTF Update Interval

255
258

46000
a2
2500
45000
10001

7700

EO000

e,

ms.

Fool ID

Pool |0 Configuration

160000071-16000010

m

e Username and Password — used for authentication with the XRT Gateway and must equal XRT Gateway

Username and password set up in MOTOTRBO Connect Plus XRT Configuration Tool.

10. Add talk paths on the Talk Paths window. They are necessary for voice communication. For each talkgroup

add one talk path, select Group in the Type column, and specify the ID. For the dispatcher add another talk

path, select Private in the Type column, and enter the Radio ID specified in step 4. Make sure these IDs

match the IDs set in MOTOTRBO Connect Plus XRT Configuration Tool (field Group ID and Console User ID).

Settings

=-#8 Radio Server

Add-on Modules
‘k: Control Stations
D-H Connect Plus
Elh Connect Flus 1

. - Radio Network Services

st Securty Settings
[0 XRC Controllers
E{ﬁ} XRT Gateways
E'h XRT Gateway

-y Radio Activity Networks
g MAI Networks
----- FN SmarttFTT Radioservers

SmartPTT PLUS 9.0

g ) Tk P

Talk Paths

[ Al Calls ]

| Add || Delete |

Mame Type D
oup Group | 1000

Group 2 Group * | 1001

Group 3 Group * | 1002

Group 4 Group * (1003

Dispatcher Private x| 101
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If required, you can define encryption settings for outgoing and incoming traffic under Security Settings.

Connect Plus with control stations

The configuration process includes the following steps:

1. Run SmartPTT Radioserver Configurator, which you have downloaded and installed, as described in SmartPTT

Software Installation.

2. Make sure you have the necessary licenses to work in Connect Plus via control stations, i.e. Voice Calls via

Control Stations for Connect Plus and Connect Plus Data Support.

3. Add a Connect Plus network and set the following parameters:

Settings | Rules | Activity | Network Configuration | Client List | Log | Export/import Settings | Statistics |

=8 Radio Server

..... "?i Licenses

-4 Fadio Network Services
-4 Add-on Medules

..... ‘E . Control Stations

G-y |P Site Connect Networks
-y Capacity Plus Systems
E_]H Connect Plus

B o s 1
L. XRC Controllers

-

ﬁ Radio Activity Metwors
E]--ﬁ MAl Systems

ﬁ SIP/RTP Inteffaces

----- F9 SmartPTT Radiossrvers
-ﬂ, Profiles

----- &5 Subscriber Groups
B-{l Metadata

Connect Plus

Active

Name
Metwork 1D
Peer ID
Radio 1D

Interface

UDP Start Port

Select Active to enable the Connect Plus network.

¢ |[n the Name field enter the name of the network.

Connect Plus 1
1
1
1

152.163.37.170 -

15000 =

¢ In the Network ID field enter the unique ID of the Connect Plus network, which is used inside SmartPTT.

This is important if you have more than one Connect Plus network. Note that this ID is different from the

Network ID defined in the XRC Controller codeplug.

¢ In the Peer ID field leave the default value. This parameter is not used in systems based on control

stations without the XRT Gateway.

¢ In the Radio ID field specify the ID of the virtual control station by default, the parameter is used to

represent the radioserver inside Connect Plus network, therefore, this ID will be used for the dispatcher (if

there is only one dispatcher). It is used for data and wice transmission.
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¢ In the Interface field specify the IP address of the virtual repeater (i.e., SmartPTT Radioserver).
e In the UDP Start Port leave the default value. This parameter is not used in systems based on control
stations without the XRT Gateway.
4. Add the necessary number of XRC Controllers and specify their settings. If you don't have the XRC Controller,

skip this step. See items 5 to 7 in Connect Plus with the XRT Gateway.

5. Add talkgroups for sending group text messages under Talkgroups. If you do not have enough of control
stations to cower all talkgroups, you can add talkgroups here, but only for sending text messages, not making
woice calls. No other settings in the XRC Controller are required.

6. Add the necessary number of control stations for group calls. In our case there are three control stations

reserved for three talkgroups with IDs 7001, 1002, and 1003.

Settings | Rules | Activity | Network Configuration | Client List | Log | Export/Import Settings | Statistics |

&=-#8 Radio Server Connect Plus Control Station
----- :?', Licenses
- Radio Network Services Active
DE gi-z: g::t?our; Name Control Station (Group 1003)
-y P Site Connect Networks IF address 192 162,13 1
w Capacity Plus Systems
[—]w Connect Plus Radio ID 1
-y Connect Plus 1 Reserved far
i3y XRC Controllers i
Ei;?; Control Stations [T Dispatcher
t.’—‘ Control Station (Group 1007) Group o0 1003

‘_‘_; Control Station (Group 1002)
B Corirl St Group 100 Neme. Group 1003
g Radio Activity Metworks
[3--“ MAl Systems
H SIP/RTP Intefaces
----- 9 SmatFTT Radioservers
-ﬂ Profiles
----- 5 Subscriber Groups
- Metadata

e Select Active to enable the control station

¢ |n the Name field enter any name of the control station. It will be used only in SmartPTT Radioserver
Configurator.

¢ In the IP address field enter the IP address of the control station. The following address format and range
are used: (001-223).(000-255).(000-255).(001-253). Users can use any address except 127.x.x.x in the
range from 1.x.x.x to 223.x.x.x. We recommend to use the address 792.168.10.1 by default. In case of
conflicts with other network interfaces select a different IP address. If two or more control stations are

connected to the computer, one of the first three octets of the IP address must be unique for each control
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¢ |n the Radio ID field enter the identifier of the control station used for communication. For control stations

reserved for group calls the Radio ID must match the Radio ID set in the settings under Connect Plus.

=8 Radio Server
- "% Licenses
i g Radio Network Services
Add-on Madules
...... "l‘-‘a Control Stations
. g IP Site Connect Metworks
..... g Capacity Plus Systems
l___| H Connect Plus
=
},~—-¢ ¥RC Controllers
-2 Control Stations
- Control Station (Group 1001)
- Control Station (Group 1002)
[t Control Station (Group 1003}
iy Radio Activity Networks
G-y MAI Systems

Connect Plus

Active

Name Connect Plus 1

Metwork 1D 1

Peer D 1

Radio 1D 1

Interfface 152.168.37.170 -
UDP Start Port 15000 =

This Radio ID must also match the Radio ID set in the control station's settings via CPS.

¢ In the Reserved for group box select Group, enter the ID of the registrations group to which the control

station is assigned (use MOTOTRBO Connect Plus Option Board CPS), and the name of the group which

will be displayed in SmartPTT Dispatcher.

7. Add the necessary number of control stations for dispatcher's private calls.

=-#% Radio Server
-4 Licenses
i # Radio Network Services
Add-on Modules
"l? Control Stations
H IP Site Connect Metworks
----- H Capacity Plus Systems
|_‘_| g Connect Plus
Elh- Connect Plus 1
L% XRC Controllers
-5+ Control Stations
[ Control Station (Group 1007)
g Control Station (Group 1002)
. o> Control Stahon {Group 'IDDS}
A Crirl Siion Dspaicher)
g Radio Activity Ne‘twcd{s
E]--H MNAI Systems
g SIP/RTP Interfaces

IP address

Connect Plus Control Station

Active

MName Cantrol Station (Dispatcher)

152.168.14.1

Radio D 1

Reserved for
Dispatcher

[ Group o [o

Mame |Group

The value in the Radio ID field must match Radio ID set in the settings under Connect Plus (if there is only one

dispatcher, and if it does not have any profile). This Radio ID should also match the Radio ID set in the control

station's settings via CPS.
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If there are more than one dispatcher, add additional control stations (one per dispatcher) and profiles (one per

dispatcher). In this case Radio ID must match ID set in the profile for each control station reserved for a

dispatcher.

=)-#4 Radio Server
B, Licenses
& Radio Network Services
| Add-on Modules
2 Cortrol Stations
i |P Site Connect Networks
 Capacity Plus Systems
my Cornect Plus
g Connect Plus 1
3 XRC Cortrollers
=& Control Stations
> Control Station {Group 1001}
. Control Station (Group 1002)
> Control Station (Group 1003)
&> Control Station (Dispatcher 101}
<> Cortrol Station (Dispatcher 102}
A Coric Stsion Diosicher 103
i Radio Activity Networks
g NAI Systems
i SIP/RTP Interfaces
-~ SmartPTT Radioservers
4 Profies
il Dispatcher 101
gl Dispatcher 102
L. Dispatcher 103
& Subscriber Groups
il Metadata

Connect Plus Control Station

Active
Name: Cortrol Station (Dispatcher 103)
IP address 192168161
Radio ID 103
Reserved for
Dispatcher
[T Group o [0

Name |Group

=¥ Radio Server
B, Licenses
& Radio Network Services
| Add-on Modules
2 Cortrol Stations
g IF Site Connect Networks
w Capaciy Plus Systems
Jmy Connect Plus
by Connect Plus 1
43 XRC Cortrollers
%2 Control Stations
41 Control Station {Group 1001)
Control Station (Group 1002)
Control Station {Group 1003)
Control Station (Dispatcher 101)
+1-5= Control Station (Dispatcher 102)
g Corttrol Station (Dispatcher 103)
 Radio Activity Networks
g NAI Systems
W SIP/RTP Interfaces
9 SmartPTT Radioservers
-4 Profiles
gl Dispatcher 101
gl Dispatcher 102
7] Deosner 03]

& Subscriber Groups
-l Metadata

Remember that in SmartPTT Dispatcher every operator must use their profile.

Linked Capacity Plus

To configure Linked Capacity Plus (LCP) system consisting of 3 sites with 2 repeaters on each site, see the

following network scheme:

SmartPTT PLUS 9.0

Profile
Name Dspatcher 103
Limt Radics to Service
Enabied
. Example: 199, 150
Mlowed redio ID's 116776415
[ BeadAl [ Colepem | [ @

[71IP Site Connect 1-Slot 1
[F1IP Ste Connect 1-Slot 2
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Site 1
ID=11

"

8

:
ID=12 =

=

5

Router+ Switch

Site 2

ID=21

ID=22

LAN Networlk

Site 3

ID=31

ID=32

LAN Networl

Router + Switch

Router + Switch

WAN [P Network

Each radio ID, either subscriber radio ID or repeater ID should be unique in the radio system. In this example you

can see 2 repeaters with ID's 77 and 72 on Site 1, 2 repeaters with ID's 27 and 22 on Site 2, and 2 repeaters with

ID's 31 and 32 on Site 3. The repeater with ID=37 is a Master.

MOTOTRBO Equipment Programming

To program MOTOTRBO equipment you will need MOTOTRBO Customer Programming Software (CPS).

1. Connect your device to the PC via a programming cable and launch MOTOTRBO CPS.

2. Switch on the device and check its settings by clicking the Read button on the menu bar.

| Fie Edit View Device

ﬁ| = E
: RM | Open Save

MOTOTRBC Customer Programming

R
Reports | Delete

Features Remote

vvar

Help

.

Cut Copy Paste

Q |>!

Search || Read

PR b ] 192168111 |

Wrte Clone | Bluetooth [
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3. In the View menu select Expert to gain access to all the setting parameters.

—

B MOTOTRBO Customer Programming

Q |ra M M f] [192.168.11.1

Cut Copy Paste | Search | Read Write Clone

Switch to Expert View [Expert View | I_m

4. In the Device Information tab make sure that firmware version is no older than:
e R01.12.11 or R02.30.10 for mobile or portable radios;
e R02.30.12 for repeaters.

Otherwise, contact the supplier to request firmware upgrade.

Note: It is recommended to use the same or compatible firmware versions for all MOTOTRBO equipment on

the same network.

== DM 3600 - T .
§ evice Information
- Bl General Settings
- Accessories Top  Device Features  Codeplug Memory Usage
-.EE Buttons
.. B8 Text Messages Model Number  M2TQNHSJAZAN
- @ Telemetry Tanapa Number FMUEZ34044
W ———— = Serial Mumber  038THS2518
- Network Firmware ID  D105ADD323864E539B51 346507645803
- @ F Range (MHz) 403.000000-470.000000
requency Range z I .
[ B8 Contacts
- B8 RX Group Lists Power Range (W)  1.0-30.0
Er}- @8 Channeis Firmware Version R01.12.10
- @8 Scan
B @8 Roam I Codeplug Version  13.01.03

5. To apply the changes in the settings, click Write.

MOTOTRBO Repeater Programming

Note: Only repeaters with 32 MB of internal memory (e.g., DR 3000 or MTR3000) can support the LCP
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configuration. Also, make sure that the repeater supports such features as Network Application Interface

Voice, Network Application Interface Data and Capacity Plus (Linked).

First of all, configure the Master repeater parameters. Each LCP system needs one repeater to act as a Master.
The Master repeater has a static IP address, while other repeaters can hawe either static or dynamic IP
addresses. All the repeaters in the LCP configuration register with the Master using the static IP address of the
Master.

1. In the General Settings tab specify Radio ID and Site ID. In our case Radio ID=37 and Site ID=3.

General Settings

Top CWID Microphone

Radio Mame IMaster

Radio ID

[ Channels Site 1D

Site Alias

H’M

SIT (ms)

Group Call Hang Time (ms)

Private Call Hang Time (ms)

Emergency Call Hang Time (ms)

3| 8| 8| 8
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2. Add parameters in the Network tab.

E-fllss DR 3000

...... ('._} Cites
Cﬁ Talkgroups
[+ Chanhels

SmartPTT PLUS 9.0

Top Radio MNetwork  LinkEstablishment IP Site Connect Capacity Plus IF Re

F!adiDIP|192.1EE. IR
Accessory [P 192.168.10.2

Metmask 25526525860

Radio Network

CAl Network |40 ==
CAl Group Metwork |225 3:
Link Establishment

Link Type | Master |

Authentication Key I

Master [P I i0 . 180 . o . 20
Master UDP Port W
pHCP [
EtermetiP | 40 . 150 . 0 . 20
Gateway P | 40 . 180 . 0 . 1
Gateway Netmask | J55 . ZBE . 285 . 0

UDP Port Im 3:
65 -

Peer Firewsll Open Timer (sec)

Master Archive File |

In the Link Type field select Master.

In the Master IP and Master UDP Port specify the IP address and port number of the Master repeater.
Do not select DHCP. Master IP address should be static.

In the Ethernet IP field specify the IP address of the Master repeater, the same as in the Master IP field.
In the Gateway IP field specify the gateway IP address for the repeater.

In the Gateway Netmask field specify the gateway netmask address for the repeater.
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¢ In the UDP Port field specify the UDP port of the repeater. The default value is set to 50000.

3. In the same Network tab specify Rest Channel/Site IP and Rest Channel/Site UDP Port.

"""" Q Accessories Radio Metwork  LinkEstablishment 1P Site Connect Capacity Flus  |P Repe

------- o et
...... ‘C_} Sites

Beacon Duration (ms) | 180

B Channels
Beacon Interval (ms) | qgog =

Rest Channel/Site IP | 10 . 180 . 2 . &8
Rest Channel'Site UDP Port |55mu 3;
IP Repeater Programming

Enable [

Rest Channel/Site IP is a virtual IP address that is required for correct operation of the LCP system. As the Rest
Channel rotates through the channel pool of a site, this virtual IP address is associated with a different physical
repeater only for the duration for which one of its slots is the Rest Channel. This IP address must be the same for
all repeaters at the same site. Rest Channel/Site IP address should be at the same sub network as all repeaters
of this site. No other device should use this IP address.

In the LCP system Rest Channel/Site UDP Port allows the user to configure the UDP port of site for

communication with other sites connected within the LCP system.
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4. In the Sites tab set up the site map. In this example we have 3 sites (see the network scheme abowe). Site 1

has only one neighbor — Site2. Site 2 has 2 neighbors — Site 1 and Site 3. And Site 3 has only one neighbor —

Site 2.
Bl DR 3000 Sites
General Seftings
Q ries Add | Delete |
g Network
Resensed - ; 3 3
...... 1 sites Site Meighbor Meighbor Meighbor Meighbor
Wide Area
Ca Talkgroups el Channels 1 : ¢ ¢
- Channels -
> 1 1] j 2 Mone Mone None
2 o :’ 1 3 MNone MNone
3 0 ﬂ 2 MNone MNone MNone

In the Reserved Wide Area Channels column you can specify how many channels are to be reserved for a wide

group call per site, if necessary.

5. In the Talkgroups tab, specify wide groups and sites on which these groups are available. You do not need to

add local groups which are available only on one site.

Bl DR 3000

------- General Settings Talkgrﬂups

....... @ Accossories

....... @ Security Al 'Wide Ares Talkgroups |

------- 2 Network

...... .(:_:) Sites Add | Delete |

....... <a Talkgroups

+- Chanhelz calib SN Site 2 Site 3
[+ > r = " T ]

2 | r v v

In our example we have only two wide groups. Group 1 is a wide group which is available on all sites. So when a

subscriber initiates a call to Group 1, this call will be transmitted on all sites. Group 2 is also a wide group and is

available on Site 2 and Site 3.

6. Set up channels. Click on Channels, right-click on Zone, select Add and then Capacity Plus Voice Channel
(Linked) or Capacity Plus Data Channel (Linked). Please remember that both repeater channels will be

used for one and the same purpose. In LCP, a Data Revert Channel can be configured either as a local Data
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Rewvert Channel, or as a wide area Data Revert Channel. In our configuration all repeaters will be used for wice,
that is why in the Master repeater settings we add Capacity Plus Voice Channel (Linked).

7. Specify Color Code and Slot Channel ID.

Channel 1

Top RX IX

: Color Cose [1 =
(:ﬁ Talkgroups Messaging Delay INormaI v|

El- & Chameis RSSI Threshold (dBm)
El- @8 Zonel

I-‘H}ﬂ : I
<-|]3? - Preference Level |1 v|
|1 3:

Slot 1 Channel ID

Slot 2 Channel ID 2

L mc (NN x

Offset (MHz)

IE.DDDDDD
Frequency (MHz) |162.075000

Copy |
Ref Freguency (MHz) IDe‘Fath Vl Ref Freguency (MHz) IDEFaLﬂ "I

Power Level m
TOT (sec) IGD 3:

Frequency (MHz) [167.300000

The color code is used to identify radio systems. Therefore, different color codes are used to identify different
systems. Channels may have the same or different color codes. However, a repeater can only have one color
code. Radios will ignore any channel activity not containing the matching color code for the system. Repeaters
using the same frequency can be associated with different color codes.

Slot 2 Channel ID is set up automatically.
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Now, configure parameters of one of the peer repeaters on Site 1.

1. In the General Settings tab specify Radio ID and Site ID. In our case Radio ID=177 and Site ID=1.

DR 3000 .
= ﬁ e General Settings
------- R Accessories Top CWID  Microphone
....... F Security
....... ﬁiﬁ' Metwork Radio Mame IPﬂerﬁ
...... <—> Sites i I—
....... Ca Tﬂkgrnups Radio 1D i
- Channels Site 1D |1 3:

Site Alias

SIT (ms)

I.S‘ite1
000
Group Call Hang Time (ms)  |3p0p ==
Private Call Hang Time (ms) | 4000

4000

Emergency Call Hang Time (ms)
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2. In the Network tab configure network settings.

El--fillisy DR 3000

% Accessories Top  Radio Metwork  LinkEstablishment  |P Site Connect  Capacity Plus  |P Repeater Programming
EEF RediolP | 192 . 168 . 10 . 1
< > Accessory IP 182.168.10.2
{ﬁ Talkgroups
= Channels Metmask 2552552650

Radio Network

CAl Network |12 3:
CAl Group Metwork |225 3:

Link Establishment
Link Type m

Authentication Key
Master P | 40 . 150 . 0 . 20
Master UDP Port W
oHoP [
EthernetIPI 0 . 150 . 2 . 5§
GatewaylP [ 10 . 150 . 2 . 1

GatewyNetnﬂsk|255.255.255. [

UDP Port m

Peer Firewsll Open Timer (sec) |5 :l;

¢ In the Link Type field select Peer.

¢ In the Master IP and Master UDP Port specify the IP address and port number of the Master repeater.

® Do not select DHCP.

¢ In the Ethernet IP field specify the IP address of the repeater. Master IP address (Site 3) and Peer
repeater IP address (Site 1) will be in different sub networks, because each site should be located in
different sub network.

¢ |In the Gateway IP field specify the gateway IP address for the repeater.

¢ In the Gateway Netmask field specify the gateway netmask address for the repeater.

¢ In the UDP Port field specify the UDP port of the repeater. The default value is set to 50000.
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3. In the same Network tab specify Rest Channel/Site IP and Rest Channel/Site UDP Port.

S jils DR 3000
------- General Settings Network

"""" Q Accessonies Radio Metwork  Link Establishment IP Site Connect Capacity Plus 1P Reg

....... &8 Talkgroups Beacon Interval (sec) IE.D 3:

- Channels
Capacity Plus

Beacon Duration (ms) |13.|:|. 3:
Beacon Interval (ms) |192.|].3:

Rest Channel'Site IP | 10 . 150 . 0 . A
Rest Channel'Ste UDP Port |55ﬂ.m 3;
IP Repeater Programming

Ensble ¥

Rest Channel/Site IP is configured in each repeater. Repeaters from the same site will have the same Rest

Channel IP address.
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4. Add channels. Click on Channels, right-click on Zone, select Add and then Capacity Plus Voice Channel

(Linked). Specify Color Code and Slot Channel ID for each channel.

DR 3000
= = Senersi Settings Channel1

- Security

e Network Color Code |1 3:
...... £ Sites )

48 Takgroups Messaging Delay | ygmal
- @8 Channsls RSSI Threshold (dBm)

El & Zonet

<|13? Channell Preference Level m
4

Slot 1 Channel ID

Slot 2 Channel ID

= ] e ]

Offset (MHz)

fo.ooo000

Copy |
Ref Freguency (MHz) IDEFaLﬂ 'I Ref Freguency (MHz) IDBfaLit 'I

Power Level IHigh v|
TOT (sec) IGD 3:

Freguency (MHz) |142.225000 Freguency (MHz) [137.225000

The Color Code must match the color code set for other repeaters.

When configuring a new site, you need to start numeration with Slot 1 Channel ID=1.

Example:
Site 3 (with Master): 1-2-Master ID=31, 3-4-Peer ID=32,
Site 1: 1-2-Peer ID=11, 3-4-Peer ID=12,

Site 2: 1-2-Peer ID=21, 3-4-Peer ID=22.

Other peer repeaters are configured likewise. When configuring, please keep in mind that:
e All repeaters from the same site should be in the same LAN.

e Each repeater must have Master IP Address/Port and Rest Channel/Port.
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MOTOTRBO Radio Programming

1. In the General Settings specify Radio ID.

= f DF3601
General Settings

Q Accessories
@A Butons

oo B Tewt Meszages

o [0 Telemetry

E [T

i Security
g Mletwiork

- Signaling Systems
[ Contacts

2

[+

R Group Lists
- [WE Channels

44

General Settings

Top tlicrophone

Password and Lock

Battery Saver Alerts

Radio Mame

Persistent LERF Requests Lone Worke

IMotorola

Radio ID

GP3

Private Callz

Site Search Timer (zec)

Select GPS, if you need to track the subscriber location (only for radios with GPS support DP/DM 3401, 3601,

4401, 4601, DP 4801, SL4010).

Select Private Calls, if radio subscriber needs to transmit private calls. If Private Call is not selected, radio

subscriber won't be able to initiate a private call, but the user can continue to receive and respond to private calls,

and is still able to initiate call alerts.
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2. In the Network tab configure the necessary settings.

= § DP 3601

- [ (General Settings
- @A Buttons

- B8 Text Messages
- ([ Telemetry

ﬁ Menu

- @ Signaling Systems
-~ RX Group Lists
- Channels

H- Sean

] Roam

H- Capacity Plus

oy O o O o O o Y o O o |

Top Radio Metwork  Services IP Site Connect

HadiDIP|192.1BE. THEE
FAocessory IP 152.168.10.2

Metmask 2552552550

Radio Network

CAl Metwark |12 3:
CAl Group Metwork |225 3:

Max TX PDU Size (bytes) [spp

Telemetry UDP Port |4uua 3;

Forward 1o PC | Dissbled -

ARS Radio ID |4

i

ARSIF 13.0.01

ARS UDP Port |4'DD5 3:
TMS Radio ID |4 =
TMSIP 0.0.00

¢ |[n the Forward to PC field select Disabled.

e If you plan to work with SmartPTT application specify ARS Radio ID and TMS Radio ID. Remember that

the ARS Radio ID and TMS Radio ID should match the MNIS Radio ID in the MOTOTRBO MNIS

application and Slot ID in SmartPTT Radioserver Configurator. In our case, ARS Radio ID=TMS Radio

ID=Slot ID=MNIS ID=1.
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3. In the Contacts tab right-click on the Capacity Plus system to add necessary contacts (Private Call, Group
Call, All Call) to subscriber’s contact list. When configuring the Master repeater, we added 2 groups as wide
groups in the Talkgroups tab. Group 1 with ID=1 is available for all sites, Group 2 with ID=2 is available for
Site 2 and Site 3. Local groups should be added in the radio settings. In this example we will add 4 groups:

Group 1, Group 2 — as wide groups, Group 3 and Group 4 as local groups, and other necessary contacts.

= § DP 380t
------- General Setings

....... Q Accessores cal
------- Buttons Contact Name cal D Receive | Ring Style E:‘::ﬂge
....... EA Text Messages Tone
------- . — o EEE o e
------- T Menu {is# | Group2 2 ﬂ [T | NoStye Repetitive
"""" @ Security £ | mican 285 H ¥ |nNoste Repetitive
------- a5 Network - - =
{5 | Dispatcher_voice 1 H I |Noste Momentary
- [ Signaling Systems
B @ Contacts fig |70 70 = ¥ | Noste Momentary
F- @@ MDC fis# | Groups 3 = T Noste Repetitve
- Quik-Cal I @5# | Groups 4 = I |Noste Repetitive
B Digital {7 | Dispatcher-Data 1 = T Noste Repetitive
= W Capacity Plus
cﬁi Group1
eiﬁ' Group2
g s
{2 Dispatcher_voice
Ga 70
------eiﬁ' Group3
3;& Groupd
¥} Dispatcher-Data
[E]- {8 Phone
Lo By 1185

Also, add Dispatcher Call for transmitting data to SmartPTT Radioserver and PC Call to be able to initiate calls
to SmartPTT Dispatcher. Make sure that the IDs of these calls equal Slot ID in SmartPTT Radioserver

Configurator (see SmartPTT Radioserver configuration).
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4. Add these groups to the RX List. In our example we use the same RXlist for all sites. That is why the RX List

contains all the groups.

= § DP3s0

- Bl General Settings
- @A Buttons

- B8 Text Messages
@@ Telemetry
cﬁ Menu

i Network

- @@ signaling Systems
B Contacts

El-- #8 RX Group Lists

Zonei
- M channe! Pocd

LCPVoice

Hyailable Members
Group1
Group2
Group3
Group4
—_ &0d
<< Remove

5. Add all repeaters, which are in the LCP system, to the Channel Pool. The color code should equal the color

code specified for repeaters. In our case Color Code=1. Define the RX and TX frequencies. They must

correspond to the frequencies set in the repeater, but RX of the radio must correspond to TX of the repeater and

TX of the radio must correspond to RX of the repeater.

= § DP3601

------- General Settings
------- ¥ Accessories
------- Buttons

------- [Ed Text Messages
....... g Tmtry

....... B Menu

H- @8 Signaling Systems
H-- Contacts

H- RX Group Lists
E]- @ Channels

Zonel

= 1 Channel Poal
B LCPSIET-11

il

8 LCPSite1-12

il

Lo | CPSite2 21

Ly LCPSIE2 22

-4

------- @00 | cPsite3-32

- ZoneZ

SmartPTT PLUS 9.0

LCPSite3-31

Top RX IX

Color Code E

Phone System I Mone - I

Offset (MHz)

Freguency (MHz) |[162.075000

Ref Freguency (MHz) IDBfath vl

Ea

Frequency (MHz) |[167.800000

Ref Freguency (MHz) IDBfath 'l
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6. Create Voice lists and Data lists according to the amount of sites. As all of our repeaters are Trunk repeaters
(transmit woice and data), create only Voice lists. When adding new Voice list, under the Available list you
can see all the channels which were added to the Channel Pool. So, for Site 1 add a Voice list (LCP Site 1)

and add LCP Site 1-11 and LCP Site 1-12 to this list.

= § e . LCP Site1

....... @ ACCESSONEs

....... Buttons Ay ailable Members D=
....... B Text Messoges e e 12
""""" @ Telemetry LCPSite2-22 LCPSite1-12 A
LCPSite3-31 [

------- M

:ﬁ Bnu_ LCPSite3-32 75
"""" e Securiy Add >> 810
....... .ﬁlia. MNetaork — 1112

- (@8 Signaing Systems
- (@8 Contacts
- RX Group Lists
Channels
- @ Scan
- @ Roam

- ieEEE
i W] LCP Site2
. B LcPsite3
Data
Sites

I I Y oy sy Y g |
()

Please note that IDs in the Members list should correspond to Slot 1 ID Channel and Slot 2 ID Channel
specified in repeater settings.

7. Create Voice lists for Site 2 and Site 3 accordingly.
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8. Configure Sites lists. If you do not use roaming, create several site lists and add only one site per list.

E- § DP38sm ]
_______ e Setie LCP Site1

_______ Button RSS! Threshold (dBm) |_1ﬂ.3 3;

------- [EE Text Messages |

Add

....... M
T menu Site ID Site Aias Veice List Data List RX Group List
------- @ Securi
ity 3 Sited LCP Sited MNone LCPVaice
....... 'ﬁEﬁ' Metwork

- @ signaling Systems
- R¥ Group Lists

[ B Channels
[
[

Delete |

. [ Scan
- Roam

R @8 Voice

Data

5 @& st

Since in this example there are three Sites, add three Sites lists.
For each Site configure:

e Site ID - ID of the site to which the subscriber radio is connected.

Site Alias — name of the site to which the subscriber radio is connected.

Voice List — Voice Channel List which the subscriber radio will use to make woice calls when on the site.

Data List — Data Channel List which the subscriber radio will use to make data calls when on the site.

e RX Group List — RX Group List which the subscriber radio will use to receive group calls when on the site.
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If subscriber roams between different sites, one site list will contain several sites.
In our case a subscriber with Radio ID=700 can roam between all three sites, so we created one Sites list with

all the sites.

= § DP3sm .
W General Settings LCP Sites

) Accessarins

B Buttons RSS! Threshold (dBm) |_1u3 =

- [ Text Messages i |

A Delete |
- (@0 Telemetry

T menu Site ID Site Aias Voice List Data List RX Group List
ity 3 1 Site LCF Site1 MNone LCPVoice
e Network

. @ Signaling Systems Site2 LCP Site2 None LCPVoice

Contacts 3
- RX Group Lists
- Channels

- Scan

. Roam

- {88 Capacity Plus

Voice

- @ Data

B @ Stes

s

Site3 LCP Site3 MNone LCPVoice

Lo i . iy

mmmmmmm
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9. Add LCP Personalities. To do this, right-click on Zone and add Capacity Plus Personality (linked).

=~ § DP 3801 .
_______ Seners Setings LCP Site1

------- ) Accessories Top RX IX
------- Buttons
....... B Text Messages ARS IOn&,rsteumSiteChangej
....... @@ Telemetry
....... T Menu Privacy [
------- @ Security Privacy Alias IPri'.fac:',r Key1 'l
....... E‘?E. Network
Bl (8 Sanaing Systems RS s fone =
(- 8 Contacts Option Board [~
[ RX Group Lists:
B Channels Lone Worker [
ﬁ Zonal Messaging Delay (ms) IGD 3:

-« LCP Sitel
-8 LCP Site2 Compressed UDP Data Header [

o8 LCP Site3
- M Channel Pool

- Zone2 Site List ILCP Sites vl

Auto Resm W

[~ Scan

< [@®@ Roam Rest Channel Acquisition TOT (min) |5 33

Bl Capacty Plus Beacon Interval (ms) |192D E
RXOnty [~

R
Emergency Alarm Indication v Contact Name IGrDum vl

Emergency Alarm Aok [ Emergency System  |gysq -

Emergency Call Indication [+ VOX
Power Level

TOT (sec)

TOT Rekey Delay (sec)

Allow Interruption

TﬂL?LILELIElT

TX Interruptible Freguencies

Admit Criteria IChannel Free j

In Call Criteria ITX Interrupt vl
R35| Threshold (dBm) I_Q,D 3:

Private Call Confirmed  [v
r

Data Call Confirmed

For each channel specify:
e ARS - select On System/Site Change. ARS feature provides an automatic radio registration. When the
radio powers up, the radio automatically registers with the server. This feature is also used with Text
Messaging or Location Services.

e Auto Roam — select Auto Roam if the radio is to roam between sites in the LCP system. If disabled, the
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radio subscriber won’t be able to roam to another LCP site when moving from one site to another.

e For each channel select appropriate Sites list. The subscriber radio can roam to the sites listed in the
Sites list.

e Select Contact Name which defines the call that may be initiated on the channel by pressing the PTT
button, when there are no active calls on the channel.

e Select Private Call Confirmed and clear Data Call Confirmed.

MNIS and DDMS Client Configuration

In order to process data packets, ARS, Call Alerts, GPS, TMS, it is obligatory to have MOTOTRBO Network
Interface Senice Configuration Utility (MNIS) and MOTOTRBO DDMS Administrative Client properly installed and
configured.

Let's start with MOTOTRBO Network Interface Senice Configuration Utility (MNIS).

Note: Before configuring, make sure the firmware versions of the repeaters and MOTOTRBO Network Interface

Senice are compatible (please find compatibility information in MNIS Release Notes).

1. In the General section in the System Operation Mode field select network type. In our case, it is Linked

Capacity Plus.

MOTOTRBO Network Interface Service Configuration Utility

Configuration  Yiew  Edit  Service  Help

Ol H G O®

2 @ 11
------- General
....... &= Security
Ei'i Group List
- 488 Lit MMNIS Application ID - [1 3
= &8 Conventional

L B

General

Swztem Operation Mode | Linked Capacity Plus
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2. In the Linked Capacity Plus section set up Master IP Address and Master UDP Port fields. These values

should correspond to the same values in MOTOTRBO CPS and in SmartPTT Radioserver Configurator, which

you will set up later.

= oA m

| General

@ Secuily

= @ GroupList
i S0 Lt
&) Corventionsl
- {ré Capacity Plus
5 e

£ B Sites
B @ Advanced
2% Network
B Fonwarding Rules
Application Overi

MOTOTRBO Network Interface Service Configuration Utility *

Configuration  Wiew  Edt  Service  Help

L HCOl@

Linked Capacity Plus

Master IP Address | 10.150.0.20

Master UDF Part 50000 E

MMIS LE Part | & Automatically Assigned

O Manualy Assigned

M one

e I:|

SmartPTT PLUS 9.0

Privarn Cathine Mena -
Settings
= B8 Radio Server NAI Network
£ Radio Network Services
‘&‘; Add-on Modules Active
% Conral Stations
Connect Plus Name [MMAI Netwark 1
Fladio Activity Networks Netwark D
= i MAl Networks
g NAI Network 1 Peer ID
1Skt =
=1 ,'n e Interface [1921680158 | Po [50000 |
1oups
B MNIS/DDMS Settings Master Repeater Addiess 107500 2050000 Test
hostport)
Authetication Key ‘ |

Top

Radio Network  Link E: nent IP Site Connect Capacity Plus [P

Radio IP 192 168 10 1
Accessory IP 182 168.10.2

Netmask 255.256.265.0

Radio Network

CAlNetwork [17 =
CAl Group Network. [325 =+

Link Establishmen
Link Type | Master -

Authentication Key

MasterP [ 10 . 180 0 . 2
Master UDP Port lm
DHcP [
EthemetiP [ 10 . 180 0 . 2
Gatewsy P [ 10 . 150 [ 1

Gatewsy Netmask | 285 . 266 . 288 )
uperort [s0000 =

Peer Firewsll Open Timer (sec) [5 =]

Master Archive File
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3. It is recommended to clear the Data Call Confirmed field in the Advanced section and to specify the identifier

in the MNIS LE ID field explicitly. Make sure MNIS LE ID does not match Peer ID of any repeaters in the

system.

MOTOTRBO Network Interface Service Configuration Utility *

Configuration

Wiew  Edit

Service

Help

(=K

=oae 1

.. FEOM  General

(g Security

(= =8 Group List

.ai Ligt1

(= {8 Conventional
:=-E Domain 1
2B Domain 2

i Capacity Phus

= 8. Linkad Capacity Plus

B Sites

= ) Advanced

-ﬁgﬁ- Metwark

=) Forwarding Rules

Application Overide Rules

Data Call Confirmed

O

Comprezzed UDP D ata Header

Battery Saver Freamble

Individual D ata to Registered Site

T# Preamble Duration [mz]

Conventional Channel Access

O

O

120

Mormal

MHIS LE ID

O Use MMIS ID
) Marually Assigned 3 -

Note: In the Firewall settings add MNIS into the exception list.

DDMS operation is closely connected to MNIS for data exchange (MNIS serves as DDMS Watcher). DDMS filters

ARS packets, received by the repeater, and information on the radio presence in the network is sent to all

systems for further processing.
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Therefore, when you configure DDMS settings, make sure that:

1. The PortWatcher field in MOTOTRBO DDMS Administrative Client matches the WatcherPort field in MNIS

settings (Advanced > Network).

e Configuration Utility

Configuration  View Edit Service Help

\j L { L‘_‘ ° @ % Service E|_Watcher Settings
- B T = =] Interfaces PortWatcher 3000
- @ Untit=d i-4/f ARS Settings Watcher10 T

File  Action Help

[0 O [&]6 [ &%

Gererzl ARS Monitor LS (PR || NotfyGroup 0
- & Loggi NotifyRat 5
O Secuty ARS Menter 1D & Losgng fyFte
& &8 Group List
- 8 Conventional PortWatcher
cg Capacity Plus Port listening for Watcher Subscribe requests.

Range: 1000 - 65535

8 Linked Capacity Plus Server Address 127001
= ﬁ Advanced Settings for Watcher interface
b | watcherpor [0 =] |

[ Forwarding Rules

2. The PORT SU field (Interfaces > ARS Settings) in MOTOTRBO DDMS Administrative Client matches the

ARS UDP Port field in MOTOTRBO Network Interface Sernvice Configuration Utility (Advanced > Networks).

~vorormooow

File  Action Help

Configuration  View Edit  Service Help

\j ) l I ° @ 0|0 0 [F]& HiE %
b By Service EL_ARS Settings
E @ Urited =] ARS Settings | Faseveode i
General Watcher Settings DeviceRefreshTime 240
. @ow Securiy CAlNetwork  [12 [+ Dersgistration TO 120
: Persistence TO 12000
& Group List
@ Conventiorial CAlGroup Network (225 | PortSU
e:é: Capacity Plus Port listening for inbound ARS messages
- Range: 1000 - 65535
- Linked Capacity Plus
=] ﬁ Advanced ARS UDF Fot |4005 = Settings for ARS/SU interface
i~ B Forwarding Ry TMS UDP Pot [4007 2]
£ Application Owvel|
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SmartPTT Radioserver Configuration
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1. Run SmartPTT Radioserver Configurator, which you have downloaded and installed, as described in SmartPTT

Software Installation.

2. In the setting tree on the left, right-click on NAI Systems, point to Add and click NAI - Linked Capacity Plus.

3. In the opened window specify the following settings of the future LCP network.

=8 Radio Server
- % Licenses
i - Radio Network Services
Add-on Modules
...... t.\ Control Stations
. ﬂ‘ IP Site Connect Networks
----- iy Capacity Plus Systems
. w Connect Plus
..... gy Radio Activity Networks
|_—_| -y NAI Systems
B P Stc Cornct 1
= T_ Slat 1
- Talkaroups
LG4 Securty Settings
[_j“]'_‘ Slot 2
o Talkgroups
L. Securty Settings
..... & DDMS Settings
----- &8 MNIS Data Gateway
w SIP/RTP Intefaces
..... BN SmartPTT Radioservers
-y Perssus Networks
D.ﬁ Profiles
-4, Subseriber Groups
E'"l__ﬁ Metadata

MAI - IP Site Connect Network

Active

Mame: MAl - IP Site Connect 1

Netwark 1D 10

Peer ID 5

Interface 192.16837.13 | Por 50000 |3
M dfﬁi;?“j;ﬁ; " 10.150.0.20:50000 Test

Authentication key

Woice transmission [Hﬂpeatars

Group call hang time, ms
Private call hang time, ms

Mz number of telephone calls
Data transmission

Manitoring

Al

100

Al

Local Slots
| Add || Delete
Mame Peer ID Slot
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e Name — add network name.

e Network ID — specify unique ID of the network. The network ID must not match any ID of the other
SmartPTT Radioserver networks.

e Peer ID — enter unique ID of the virtual repeater in the network. The virtual repeater ID must not match any
of the other repeater IDs in this network.

¢ Interface — specify the IP address of the PC where SmartPTT Radiosenrver is installed.

e Port — set up port number of SmartPTT Radiosenrver. It should differ from the corresponding ports in other
networks.

e Master repeater address (host:port) — specify IP address and port number of the Master repeater (see
Master IP and Master UDP Port in MOTOTRBO CPS). In this example it is 70.750.0.20:50000.

e Click Test to check connection between the virtual and Master repeaters.

e Authentication Key — enter repeater authorization key (to be equal to the Authentication Key in the
repeater settings in MOTOTRBO CPS). In this example we are not setting any authentication keys.

e Voice transmission can be carried out in two ways: via repeaters and via control stations. To transmit
woice via control stations, configure control station parameters and profiles for making private calls. To
transmit voice via repeaters, configure virtual control station channels and talkgroups of the channel. The
number of channels depends on the network type. To ensure data packets transmission over the network,
configure the DDMS and MNIS senices. To transmit CSBK commands use control stations for woice
transfer. To transmit data and monitoring data select the corresponding check boxes (Data transmission
and Monitoring). If Data transmission is not selected, all data packets will be gray and no data type
differentiation will be applied in the Monitoring panel in SmartPTT Dispatcher. If Data transmission is
selected, the data packets addressed to you will be defined, and other data packets, not addressed to

you, will be gray.
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4. Configure slot parameters. In order to do that, go to Slot 1 in the setting tree of SmartPTT Radioserver

58

SmartPTT PLUS 9.0

Configurator.
=-F8 Radio Server HAl Control Station
----- :ﬁ Licenses )
-5 Radio Network Services Active
Eg---'&_\_. Add-on Modules
----- &> Control Stations Name  Slot 1
-y |P Site Connect Networks _ =
g Capacity Plus Systems Radio ID ! =
ﬁ Connect Plus CAl Netwark 12 =
ﬁ Radio Activity Metwors
g NAI Systems CAl Network for Groups | 225 %
Eh MAl- Linked Capacity Plus 1
EI“[‘ Allow Telephone Interconnect
1" Sites T¥ Time-Out Timer, s |60 =
Talkgroups )
-2k Securty Settings Options
_ B DDMS Settings Emergency Alarm Corfimed
-3 MNIS Data Gateway _
-4ag SIP/RTP Interfaces Allow Transmit Intemupt
----- B9 SmartPTT Radioservers .
-ﬂ Brofiles GPS Trangmigsion Mode | Data -
----- &5 Subscriber Groups
Eﬂ--[ﬂ Metadata Corfimed events

Private Call Corfirmed

e Name — specify the name of the slot.

e Radio ID — set unique ID of a virtual control station corresponding to the network slot. Remember that it
should match ARS Radio ID, TMS Radio ID and MNIS ID, in this example it is 7.

e CAIl Network — CAl-network ID. Use the default value of 12 (must match MOTOTRBO CPS settings).

e CAIl Network for Groups — CAl-network for groups ID. Use the default value of 225 (must match CAI
Group Network in MOTOTRBO CPS settings).

e Emergency Alarm Confirmation — select this check box if you need the emergency alarm be

acknowledged.

¢ Private Call Confirmed — select this check box if you need set private calls on the current digital channel

as confirmed.
e Allow Transmit Interrupt — select this check box if you need the ability to interrupt a radio subscriber.
e GPS Transmission Mode — allows you to select the way how to transmit location updates: as a data
packet in multiple bursts or as a single CSBK (Control Signaling Block). This time select Data.

e Allow Telephone Interconnect — select this check box if you need the ability to make telephone calls
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5. Configure talkgroup parameters. To do that, click Talkgroups. Parameters of wide area and local groups are

set in the Control Station Talkgroups window. In order to display wide area talkgroups by the SmartPTT

Dispatcher application, add necessary talkgroups in SmartPTT Radioserver Configurator, define group identifiers

which correspond to the identifiers of the wide area groups in the repeater MOTOTRBO CPS settings and

select Wide in the Site Number field. In this example we have two wide area talkgroups and two local

talkgroups, so we add them into SmartPTT Radioserver Configurator.

=9 Radio Server
..... ’% Licenses
-4 Radio Network Services
[ .} Add-on Modules
..... 'E: . Control Stations
-y IP Site Connect Networks
gy Capacity Flus Systems
H Connect Plus
gy Radio Activity Networks
Sl NAI Systems
=g MAL- Linked Capacity Plus 1
B I Slat 1
L "[ Sites

i % Security Settings

4y SIP/RTP Interfaces

Control Station Talkgroups

ow ] por

[ Al Calls ]

[ Add ” Remaove ] ’ @ Up ¢ Down
Mame Site Mumber D

Group 1 Wide |1

Group 2 Wide |2

Group 3 2 >3

Group 4 *|4

Talkgroups not specified in the repeater settings are regarded as local groups. Local group call does not go

beyond the site on which the call was initiated.

To add local talkgroups, just add them in SmartPTT Radioserver Configurator, define their identifiers and select

site number from the list in the Site Number field.

Note: Wide area and local talkgroup identifiers must differ.

SmartPTT PLUS 9.0

Installation & Configuration Guide



Linked Capacity Plus

60

6. Configure MNIS Data Gateway and DDMS settings for data transmission under MNIS Data Gateway and

DDMS Settings.

=B Radio Server

~F Licenses

-4 Radio Network Services
... Add-on Modules

E Control Stations

IP Site Connect Metworks
Capacity Plus Systems
Connect Plus

MMIS Data Gateway

Socket Type
MNIS Cortrol Interface
Interface

MNIS ID
Radio Activity Networks
NAI Systems
B--H NAI- Linked Capacity Plus 1
=N “L " Slot 1
"% Stes
Talkgroups
-5k Security Settings
-8 DDMS Settings
‘=
g SIP/RTP Intefaces
9 SmartPTT Radioservers

Location Port
TMS Port

Telemetry Port

locahost:5000 |

B Radio Server

~F Licenses

-4 Radio Network Services

4. Add-on Modules

-2 Cortrol Statiors
IP Site Connect Metworks
Capacity Plus Systems
Connect Plus
Radio Activity Networks
NAI Systems

= H NAJ- Linked Capacity Plus 1
== "L Slot 1
'¢ Stes

Talkgroups
4 Security Settings
& _§ DDMS Settings

-G MNIS Data Gateway
‘ SIP/RTP Interfaces

DDMS Settings
Active

Server Address  192.168.37.13:3000

1) Under MNIS Data Gateway select Local Socket in the Socket Type field since the MOTOTRBO Network

Interface Service Configuration Utility application is installed on the same PC as SmartPTT Radioserver.

2) MNIS Control Interface — use localhost, if MOTOTRBO Network Interface Senice is installed on the

same PC as the radioserver. If MOTOTRBO Network Interface Senvice and the radiosenrver are installed on

different PCs, use the interface specified in the MNIS Relay Address field. The port should match the port

number specified in the MNIS Control Interface TCP Port field in MOTOTRBO Network Interface Senvice

Configuration Utility settings:

MOTOTRBO Network Interface Service Configuration Utility

[+ {88 Conventional
------ §ie. Capacity Plus
- @ Lirked Capacity Flus

Advanced

[ Forwarding Rules

SmartPTT PLUS 9.0

(- Application Dvermide Rules

Configuration  Wiew  Edit Service  Help
= a1 ARS Manitar D |Fone ~
------- General
------- @ Security Device Discovery and Mobhility Service
[+ 8 Group List

Server Addiess | 127.0.0.1

W atcher Port

MNIS Control Interface

MMIS Control Interface TCP Port 5000 -

|A
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3) In the Interface field select the IP address of the PC where MOTOTRBO Network Interface Senice is
installed. It must match the IP address specified in the Tunnel IP Address field of MOTOTRBO Network
Interface Senvice Configuration Utility.

4) In the MNIS ID field set up the Common Air Interface (CAI) ID of the MNIS in the radio network. The ID is
used by other calling radios when addressing MOTOTRBO Network Interface Service. Make sure MNIS ID
matches the MNIS Application ID field in the General tab in MOTOTRBO Network Interface Senice

Configuration Utility. It is also recommended that MNIS ID should match Radio ID in the radioserver slot

settings.
MMIS 7 i 3 e
MOTOTRBO Network Interface Service Configuration Utility
Socket Type |Local Socket v |
- Configuration  Wiew  Edit  Service  Help

MnisConhiol Interface [lacalhost 5000 || i ;
Interface 192,168 50.2 | 1 v i \j l p H ‘ Ca o ‘ @
MNIS 1D [1 [2]2 = @ m General

o BB General
Location Port 4001 £ .

@ Secuity . -

= System Operation Mode | Linked Capacity Plus v

TMS Part 4007 - [ @8 Group List

: B List 2 I MHIS Application 1D [1 2 |
Telemetry Part 4008 ke # ppicaten =

|3 & Conventional
=B Domain 1

. Capacity Fluz Tunnel Network

- Linked Capacity Plus

" B Sites MMIS P Addiess  [192.168.50.1

o @8 Advanced 1 |Tunne| IP Addiess  192.168.50.2 I

------ 'EEE Metwork

...... b Fowarding Rules Subnet Mask  255.255.255.0
------ Application Overide Fules

5) In the TMS Port, Telemetry Port and Location Port fields specify ports where the radioserver will expect
text messages, telemetry and GPS data. The ports should match the ports set in the TMS UDP PORT,
Telemetry UDP Port, Location Server UDP Port fields in MOTOTRBO Network Interface Senvice

Configuration Utility (Advanced > Network).
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6) Under DDMS settings specify Server Address, i.e., IP address of the PC with the MOTOTRBO DDMS
Administrative Client application installed, and port number of the DDMS senwer. In this case the DDMS
sener is installed on the same PC as the radioserver. The port number in this field must match the port

number in the PortWatcher field of the MOTOTRBO DDMS Administrative Client (Interfaces > Watcher

Settings).
TaeTs—SEee
DDMS i| Fle Action Help
Server Address 192.168.37.13 -BDDD A —
000 [U]%|HE %
Service El Watcher Setti
E-NF Interfaces I PortWatcher 3000 I
\!E ARS Settings atcher 10 T
P o3 NotifyGroup o

Fe |
7. Sawve changes by clicking Save . To cancel the changes made, click the Restore button Ej . All the

changes, made after the last save, will be restored.To apply the saved changes you must restart the senvice.

The senice is managed using the following buttons: Start @ Stop and Restart @ .

Capacity Max

Capacity Max is a trunking MOTOTRBO system that supports the European Telecommunications Standards
Institute (ETSI) Digital Mobile Radio (DMR) Tier Il operation.

Capacity Max system represents the enhancement of the Linked Capacity Plus functionality. It can include up to
15 sites and up to 15 trunked repeaters with up to 3,000 users per site. One slot on each site is allocated as a
control channel. Capacity Max also supports data revert repeaters—up to 6 per site and 12 time channels per
site.

Capacity Max systems offer the following advantages:

e The simple and efficient system architecture that utilizes standard Internet protocol (IP) network with a

centralized Capacity Max System Sener (CMSS).
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Ly MNisData IP Network
1} Gateway
SmartPTT ESX Server
Radioserver Capacity Max System Server

NISVRC| | Trunking
Gateway | | Controller

IP Network

SmartPTT SmartPTT SmartPTT
Dispatcher Dispatcher Dispatcher
Console Console Console

CMSS represents the VMware Sphere version 5.5 ESX server and includes the following virtual resources:
o Trunking Controller based on the Red Hat Linux,
o MNIS VRC gateway, and
o Radio Management application that is used instead of MOTOTRBO Customer Programming Software
(CPS) to configure the system.
The system architecture also includes the MNIS Data gatewaty, which is installed separately.
e High security. All wice, data and control traffic within the IP network is encrypted, and all radios are securely
authenticated.
e High level of reliability and resilience. The system can include an optional redundant server in addition to the
main server and up to three alternate control channels per site.
Capacity Max is compatible with all MOTOTRBO repeaters, except DR3000 series with the 8MB RAM, and all
MOTOTRBO 4000 series portable and/or mobile radio stations.
To configure the Capacity Max system in SmartPTT Radioserver Configurator, you will need to use the following
applications:
e Radio Management application—to get the settings of the preconfigured virtual resources, and
e MOTOTRBO Network Interface Senice Configuration Utility—to set up the MNIS Data gateway.

Capacity Max configuration in SmartPTT Radioserver Configurator includes the following steps:
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1. Adding new network and its basic configuration.

2. Setting up the trunking controller.

3. Setting up MNIS Data gateway settings for data transfer.

4. Setting up the MNIS VRC gateway and the talkgroups.

5. Setting up the security settings.

How to Configure Capacity Max

To add a new Capacity Max system, right-click Capacity Max Networks in the setting tree of SmartPTT

Radioserver Configurator and click Add.

At that, Capacity Max System configuration menu appears on the right.

Settings | Rules | Activity | Network Configuration | Client List | Log | Export/import Settings | Statistics |

=% Radio Server Capacity Max System
% Licenses )
i | Act
[+ Radio Network Services e
. Add-on Modules Name Canacity Max 1
g‘_; Control Stations i
ﬁ’ IP Site Connect Networks Networl 1D 2
ﬁ’ Capacity Plus Systems Radio ID 600
-y Connect Plus
[-lag Radio Adtivity Networks Interface | Any -
w MNAI Systems ) )
- SIP/RTP Interfaces Fresenee infomation
B9 SmatPTT Radioservers Data transmission
= Capacity Max Metworks
ﬁh‘ Capacity Max 1 Voice transmission
- Trunking Controller Allow transmit intemupt
-, MNIS Data Gateway
Bh‘ MNIS VRC Gateway Priortize calls during emengency
. & Talkgroups Channe! Grant Watting timer (s): 15 2
Lt Security Settings =
'ﬁ F‘rofﬁfis T time-out timer (s): 60 (=
--ign Subscriber Groups GPS transmission mode: | Data -
[]--Dj Metadata

Name: Name of the created system.

Network ID: Unique ID of the network. The network ID must not match any ID of other SmartPTT Radioserver

networks.
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Radio ID: The identifier of the radioserver. This is the identifier radio subscribers will see at receiving private calls
and text messages from the dispatcher. If there are several dispatchers, you can create a profile for each operator
(Profiles) and define a unique identifier for each operator. Radio ID set in this window must correspond to the
value set in the Device ID field for the preconfigured radioserver device in the Radio Management application (see

the Capacity Max Systems settings, sorted by the Subscriber Access Control value).

E Radio Management EI

]O

Capcity Max Systems » Subscriber Access Control

Capcity Max System

View by: (@) Subscriber Access Control () Talkgroup Site Association

[+ [ d

OurSysteml

Device Type Serial Number Physical Serial Numbe

Console g a 500 6 - <All Sites>
Data Gateway 0 [1] 301 6 <Al Sites>
Console g a 601 6 * <Al Sites>
Voice Gateway O (1] 201 ] ~ <Al Sites>
Motorola Radio  871TNV1525 I1E0408845C768584329F 506 ] ~ <Al Sites>
Console (/] [ 6503 6 - <All Sites>
Console 0 o 602 6 v <Al Sites>
Console g [ 604 6 * <Al Sites>
Console 0 o 605 ] v <Al Sites>
Motorola Radio  807TQH1216 0CDO025424B05C04BEG6: 505 6 v <Al Sites>
{ 4

10 items found (0 currently selected).

Analyze Results| |Tasks
Connected To:LOCALHOST

Note: To open the Capacity Max System settings in the Radio Management application, click Actions >

Manage > Capacity Max System Server Data or press the Ctrl+Shift+G together.

Interface: The IP address of the PC where SmartPTT Radioserver is installed.

Presence information: Select this check box to enable connection with Trunking Controller.

Data transmission: Select this check box to work with MNIS Data Gateway.

Voice transmission: Select this check box to enable MNIS VRC Gateway.

Allow transmit interrupt: Select this check box if you need the ability to interrupt a radio subscriber.

Prioritize calls during emergency: Sets a priority of the dispatcher call during the Emergency Call. If the check

box is selected, the dispatcher call has the highest priority during the Emergency Call in relation to other calls
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and interrupts them in case of lack of resources.
Channel Grant Waiting timer: Time period in seconds during which the caller expects a response from the
called party (the FOACSU strategy). It is recommended to use the default value of 15 seconds that is set in the

Radio Management application (see the Capacity Max Systems.... settings in the Capacity Max Features

menu of the CMSS Config configuration, the Channel Grant Waiting timer field in the Timers tab).

[=] Radio Management =l ===

&

Configuration View » CMSS Config » Capacity Max Systems » OurSysteml

Set Categaries ]

Save As Clase
[@  Configuration: CMSS Config

General  Security  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
+ W Capacity Max Features

(]  Capacity Max Systems: CapacityMaxSystems-1

@ Capacity Max Site Selection: CapMaxSystemSit =) Timers
[l Network: Netwark-1 Channel Grant Waiting timer (sec) ‘ 13 I
L v Respanse Waiting timer (sec) [20 I
Group Call Hang Time (sec) |3
Private Call Hang Time (se) |4
Emergency Call Hang Time fsee) |4
Inter-Repeater Messaging Delay (ms) | Normal 2
1 ——— — 4

»

Analyze Result:'.| Tasks |Validaﬁnn Results|Warning Messages Search Resuhs|Help‘
Connected To:LOCALHOST

Note: To open the Capacity Max Features of the CMSS Config configuration in the Radio Management
application, click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select
the CMSS Config item and click Edit. In the Set Categories tab that opened, click Configuration: CMSS

Config > Capacity Max Features.

FOACSU (Full Off Air Call Set Up) stands for the strategy of assigning the traffic channel only when the called

party user has specifically answered the call. During the timeout the traffic channel is not allocated for the call.

SmartPTT PLUS 9.0 Installation & Configuration Guide



Capacity Max 67
For correct work of the FOACSU private calls, make sure that it is configured in the Radio Management
application (see the Capacity Max Systems.... settings in the Capacity Max Features menu of the CMSS
Config configuration, the Individual Voice Call Type field in the General tab).
Radio Management [E==EcRF=7)
Configuration View » CMSS Config » Capacity Max Systems * OQurSysteml
Set Categories L
Save As Clase
& Configuration: CMSS Config
v T Copacity Max Features General  Security  Timers  Capacity Max Sites  Adjacent Sites  Site Announcement
]  Capacity Max Systems: CapacityMaxSystems-1 Last Modified Date 01/29/2016 12:52: a
[  Capacity Max Site Selection: CapMaxSystemSiteS. Comments |
[ Network: Network-1
» I vNs T-General
System Name | Cursystem1
SystemType | Capacity Max Adve
Network Model | Large
NetworkID |1
Stun/Revive Authentication O
Individual Voice Call Type [Foacsu |
Call Queue Enable D
Max Infrastructure Voice Interrupt Attempts |3
Max Preemption Interrupt Attempts ‘ 6
Primary Trunking Contreller IP [172161.10
- - - W e [ —
3
4 »
Analyze Results| ’E‘ |Validaﬁnn Results |Warning Messages Search Results|Help‘
Connected To:LOCALHOST
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TX time-out timer: Time period during which the radio can transmit without interruptions. After this time is over,
the transmission is interrupted. It is recommended to use the default value of 60 seconds, which is set in the
Radio Management application (see the MNIS System settings in the MNIS menu of the CMSS Config

configuration, the Transmission TOT field in the General tab).

ERadio hanagerment EI

G]O LRy

Configuration View » CMSS Config » MNIS System » MNISSystem-1

Set Categories q

H E Configuration: CMS5 Config e
Close
v T  Capacity Max Features

General  Tunnel Network
@ Capacity Max Systems: CapacityMaxSystem

El Capacity Max Site Selection: CapMaxSysten ~) General B
] MNetwork: Network-1 Capacity Max System | OurSysteml n
v U MNIS MNIS Application D | 201 | 8
D MNIS Security: MNISSecurity-1 MINIS LE Port |2017| g
D MNIS System: MNISSystem-1 £ Transmission TOT (sec) |507 I

ﬂ MNIS Advanced: MNISAdvanced-1
Request CSBK Data ||
D MMNIS Netwark: MMISNetwork-1

Talkpath Limit | 30 |
ﬂ MNIS Forwarding Rules
Data Queue Size |25 |
ﬂ MNIS Application Override Rules - - -

4 »

Analyze Results| | Tasks ‘\"alidation Results |Warning Messages |Search Result’.‘HeIp|

Connected To:LOCALHOST

Note: To open the MNIS menu of the CMSS Config configuration in the Radio Management application, click
Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the CMSS Config

item and click Edit. In the Set Categories tab that opened, click Configuration: CMSS Config > MNIS.

GPS Transmission Mode: Allows you to select the way how to transmit location updates: as data packet in
multiple bursts or as a single CSBK (Control Signaling Block).

Each solution has its own advantages and disadvantages:

GPS Advantages Disadvantages

Transmission

Mode

Data e No need to configure additional settings for e Increased traffic load on a channel
receiving GPS data

CSBK e Low traffic load on a channel e Not all radios support CSBK commands

e Increased GPS transmission frequency rate
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Enhanced °

CSBK .

—once in 15 seconds

Low traffic load on a channel

69

e Not all radios support CSBK commands

Increased GPS transmission frequency rate

—once in 7.5 seconds

Trunking Controller

To set up trunking controller click Trunking Controller.

Settings | Rules | Activity | Network Configuration | Client List | Log

| BExport/Impart Settings | Statisticsl

=¥ Radio Server
----- ?. Licenses
[-gf Radio Network Services
-4 .\ Add-on Modules
E Control Stations
[j--g IP Site Connect Metworks
[j--H‘ Capacity Flus Systems
U"H Connect Plus
[j--g Radio Activity Metwarks
(- MNAI Systems
[j--H’ SIP/RTP Inteffaces
----- BN SmartPTT Radioservers
[—jH‘ Capacity Max Networks
E|h- Capacity Max 1
I rriing Corirler

- MNIS Data Gateway
E-ig MNIS VRC Gateway
a Talkgroups
-4 Security Settings

Trunking Controller

Primary controller address and port

Redundant controller address and port

172.16.11.10:50015

Note: The Presence information check box in the Capacity Max window should be selected. Otherwise, the

Trunking Controller parameter will not be shown.
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Primary controller address and port: IP address and port of the primary virtual trunking controller, preconfigured
in the CMS senver. The IP address in this field must match the value set in the corresponding fields in the Radio

Management application (see the CMSS Network:... settings in the Capacity Max Features menu of the CMSS

Config configuration, the Trunking Controller IP field and the Presence Server IP field in the General tab).

-

Radio Management EI@

L

Configuration View » CMS5 Config » CMSS Metwork » Metwork-1

Set Categories 1

Close
A E Configuration: CM55 Config

v Tl Capacity Max Features General
@ Capacity Max Systems: CapacityMaxSystem
[2] Capacity Max Site Selection: CapMaxSysten ~) General -
[ ] CMSS Network: Network-1 £ | cMssTP | 1721618 |
> s CMSS UDP Port | 50000 |
Trunking Controfler i 172.16.1.10:50000
Fresence Server[f 172.16.1.10:50015
VRC Gatewa) [P 17216117
System Advisor P 17216.1.14
CMSS Internal Netwark | 192.168.231.0 |
Gateway IP | 172.16.1.254 |
Gateway Netmask | 255.255.255.0 |
NTP Server |0.0.0.0 | n
4 I— »
Analyze Resulis| |Task5 | |Validaﬁon REL.IHS
Connected To:LOCALHOST Radio Countl

Redundant controller address and port: IP address and port of the redundant virtual trunking controller. This
field is optional. If you fill in this field, ensure that the corresponding values are set in the Radio Management

application.
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MNIS Data Gateway

To set up data transfer over Capacity Max network, set up MNIS Data Gateway settings in SmartPTT Radioserver

Configurator and in the MOTOTRBO Network Interface Senice Configuration Utility.

To set up MNIS Data Gateway settings in SmartPTT Radioserver, click Capacity Max Networks > Capacity
Max > MNIS Data Gateway.

=-#9 Radio Server MHIS Data Gateway
:?, Licenses
[-€¢ Radio Network Services Socket Type [Lccal Socket ']
- . Add-on Modules
E Cortral Stations MMIS Control Interface  localhost :5000
-4y IP Ste Connect Networks Interface [132 168.10.2 ,]
U"W Capacity Plus Systems —
[y Connect Plus MNIS ID 301 =
gﬁ ﬁ;?lg}:ﬁ:::y Networks Location Port 4001 o
[j—-ﬁ SIP/RTF Interfaces TMS Part ADOT =
B SmartPTT Radioservers
El-img Capaciy Max Networks Telemetry Port 4008 =
Bh- Capacity Max 1
g Trunking Controller
= i FPanmmamad iimss

Note: The Data transmission check box in the Capacity Max window should be selected. Otherwise, the MNIS

Data Gateway parameter will not be shown.

Socket type: Defines the software interface type to enable communication between processes. Select the Local
Socket value if the MOTOTRBO Network Interface Senice Configuration Utility is installed on the same PC as
SmartPTT Radioserver. Select Remote Socket if MOTOTRBO Network Interface Senice Configuration Utility and
SmartPTT Radioserver are installed on a different PCs. In this case, information exchange between the processes

is supported by the MNIS Relay application.
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MNIS Control Interface: Use localhost, if MOTOTRBO Network Interface Senice Configuration Utility is installed
on the same PC as the radioserver. If MOTOTRBO Network Interface Senice Configuration Utility and the
radioserver are installed on different PCs, enter the IP address of the PC where MOTOTRBO Network Interface
Senice Configuration Utility is installed. The port should match the port number specified in the Radio
Management application (see the MNIS Network settings in the MNIS menu of the DataMNIS Config

configuration, the Control Interface TCP Port field in the General tab).

Radio Management EI

G]O

Configuration View » DataMNIS01 Config * MNIS Network * MNISNetwork-101

Set Categories q

v E Configuration: DataMMNIS01 Config
» [l Capacity Max Features
v T MNIS
|‘:| MMIS Security: MNISSecurity-101
D MMNIS System: MNISSystern-101 ~' General a
[| MNIS Advanced: MNISAdvanced-101

Close

General

CAI Network |12 K=
| (] MINIS Network: MNISNetwork-101 3t | -
|‘:| MNIS Forwarding Rules CAl Group Network |225 | =
D MNIS Application Override Rules TS UDP Port |4[]'[J:‘I | g
(] MNIS Sites: MNISSitesList-101 Telemetry UDP Port | 4008 | 8
Lacation Server UDP Port | 4001 K=
User Defined UDP Port 1 [0 - Disabled | 3
User Defined UDP Port 2 |0 - Disabled | &3
User Defined UDP Port 3 [0 - Disabled | &3

KCMP High Efficiency Data Enable [ |

NCMPE Server UOP Port 4004
Battery Management UDP Port |4009 | g
I Control Interface TCP Part | 5000 | gl S
4 »
Analyze Results| [Tasks| | Validation Results [t L ] Search Results|Help |
Connected To:LOCALHOST Radic Count1

Note: To open the MNIS menu of the DataMNIS Config configuration in the Radio Management application,
click Actions > Manage > Configurations or press Alt+C together. In the table that opened, select the
DataMNIS.. Config item and click Edit. In the Set Categories tab that opened, click Configuration:
DataMNIS.. Config > MNIS.
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Interface: MOTOTRBO Network Interface Senvice interface. It must match the interface specified in the Radio
Management application (see the MNIS System settings in the MNIS menu of the DataMNIS Config

configuration, the Gateway Tunnel IP field in the Tunnel Network tab).

Radio Management EIE

L

Configuration View » DataMNIS01 Config » MMNIS System  » MNISSystem-101

Set Categories 2

v E Configuration: DataMNIS01 Config

§ Device Information: DATAMINSOL Close
» Capacity Max Features General  Tunnel Network
v T MNIS
D MNIS Security: MNISSecurity-101 Enhanced Data Enabled | | -
[ {] MNIS System: MNISSystem-101  §3¢ ] Active Voice Talkpath Limit | 0 g
D MNIS Advanced: MNISAdvanced-101 Data Gateway Queue Size | 25 g

D MMIS Network: MMNISNetwork-101

TX Privacy Type | MNone n
D MNIE Forwarding Rules

. . TX Privacy Alias None
D MNIS Application Cverride Rules

D MMNIS Sites: MMISSitesList-101 ~ Tunnel Network

Gateway IP | 192.168,10.1

IG&a‘ewa)fTunneHP 182188102 I

1

4 — >
Analyze Results| |Task5| |Validaﬁon Results RUETUTLL R AEEELICT) il Search Results |Help
Connected To:LOCALHOST Radio Count:1
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MNIS ID: The Common Air Interface (CAl) ID of the MNIS in the radio network. The ID is used by other calling

radios when addressing MOTOTRBO Network Interface Service. Make sure MNIS ID matches the corresponding

field in the Radio Management application (see the MNIS System settings in the MNIS menu of the DataMNIS

Config configuration, the Data Gateway Radio ID field in the General tab).

Radio Managernent

L]0

Set Categories

v T MNIS

Analyze
Cennected To:LOCALHOST

: -EI -FH
Configuration View * DataMNISOL Config * MNIS System »* MNISSystem-101*
Save Discard
v 5] Configuration: DataMNISO1 Config
§ Device Information: DATAMINSOL Close
» [ Capacity Max Features Genersl  Tunnel Network
(7] MNIS Security: MNISSecurity-101 A
[ (] MINIS System; MNISSystem-101* ¢ | ~) General
{"] MNIS Advanced: MNISAdvanced-101 Data Gateway Radio D | 301 | E
G MNIS Network: MNISNetwork-101 MNIS Gateway UDP Port | 301 | g
["] MNIS Forwarding Rules @
Transmission TOT (sec) | 60 | =]
(7] MNIS Application Override Rules
Enhanced Datz Enabled | |

G MNIS Sites: MNISSiteslist-101 o

Active Vioice Talkpath Limit |0 |8

Data Gateway Queue Size |25 | g

TX Privacy Type | None n
-
Results| |Tasks| |Validation Results Waminq [AES=L i Search Results |Help
Radic Count:1

Location Port: The port where the radioserver
will expect GPS data.

TMS Port: The port where the radioserver will
expect text messages.

Telemetry Port: The port where the radioserver
will expect telemetry data.

The ports should match the ports set in the
corresponding fields in the Radio Management
application (see the MNIS Network settings in
the MNIS menu of the DataMNIS Config

configuration, the Location Server UDP Port

Fadio Management

ki

Configuration View » DataMNISOL Config » MNIS Network » MNISNetwork-101

(E=8 B0 5

Set Categories
~ &l Configurstion: DataMMISO1 Config
. Device Information: DATAMINSO1
» [ Capacity Max Features
v T MNIS
(] MNIS Security: MNISSecurity-101
(] MNIS System: MNISSystem-101
G MNIS Advanced: MNISAdvanced-101

)

Close

General

~) General =

CAT Network | 12

[ (] MNs Networke MNISNetwork-101 g

CAL Group Network | 225

(7] MNIS Forwarding Rules
(7] MNIS Apilication Override Rules
G MNIS Sites: MNISSitesList-101

Analyze Results| [Tasks| Validation Results [Mat e LN  carch Results | Help

| Connected To:LOCALHOST

»

TMS UDP Port | 4007

Telemetry UDP Port | 4008

Location Server UDP Port | 4001

User Defined UDP Port 1 |0 - Disabled

User Defined UDP Port 2 |O - Disabled

lcar Rafinad 1100 Dart 2 [0 _ Ricantad

Radio Count1

field, the TMS UDP Port field, the Telemetry UDP Port field in the General tab).
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To set up MNIS Data Gateway settings in MOTOTRBO Network Interface Service Configuration Utility, do the

following:

1. Save MNIS Data Gateway settings from the Radio Management application as GWCFGXfile. For that, click
Radios, right click the DATA MNIS... item in the table that opened and click Export > GWCFGX... or press

Ctrl+Shift+N together. In the Export GWCFGX window that opened, specify the file name and click OK.

75

Radio Managerment

G JO

Radio View

Groups q

=

Connected To:LOCALHOST

Show Details.. Edit Configuration... Analyze
/182 g l- ‘
Serial Number Radio Alias Configuration Group Modified Job Status | Job Name
P DATAMINSOT Motorola 0 01 Confia None
“7ERUIZIS Show Details... Ctrl+W m omom W m Completed White without Switchover 02/04/2016 06:04-21(1
478IRUIZ23 Delete Del = om om omwm Completed  Wiite without Switchover 02/04/2016 04:57:15(1
LTRIRCO0IE Select Group.. Ctrl+Alt+G = m mmwm (ompleted Wiite without Switchover 02/04/2016 06:06:00(t
BOFTQHIZ1E = m m om wm Completed  Wite without Switchover 02/05/2016 09:13:34(1
S7ITNVISZS Edit Configuration... Ctrl+F =W m W W (ompleted  Wiite without Switchover 02/04/2016 04:00.05(1
USESIOPLYA Select Configuration... Alt+Shift=F = omom mm (pmpleted Wite without Switchover 02/°09/2016 08484311
Select IP System Settings...
Ctrl+)
Alt+Shift=]
Select M Alt+Shift+V
Analyze Alt+Shift+S
‘ Repo 5
Upgrade Firmware...
7 items found (1 Export_ , Radic. Cirl+Shift+R
Modify Radio Grid to File... Ctrl+Shift+5
GWCFGK.., Ctrl+Shift+N
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2. Transfer the saved GWCFGXfile to your PC where the MOTOTRBO Network Interface Senice Configuration

Utility is installed, to the Config folder that is located on the local disk C:/ProgramData/Motorola/Wireline

Gateway.
F=N o =
@Ovl .. » Computer » Local Disk (C) » ProgramData » Motorola » Wireline Gateway » Config - |."’ | | Search Pro.. 2 |
Organize v Include in library ~ Share with « New folder =~ @

% Favorites Mame Date modified Type Size
Ml Desktop | CapacityMax.gwcfgx 08.02.2016 12:37 GWCFGX File 3 KB
& Downloads = gw_default_tuning.xml 280420141711 XML Document 3KB
1412.2015 16:47 XML Document 1KB

& .
= Recent Places =] gw_indexxml

. Libraries
@ Documents

J’ Music
[E] Pictures
B videos

18 Computer
£, Local Disk (C3)

'?j Metwork

’ & items

SmartPTT PLUS 9.0

Installation & Configuration Guide



Capacity Max 77

3. Launch MOTOTRBO Network Interface Service Configuration Utility and click Configuration > Select Active
Configuration. In the Select Configuration window that opened, select the GWCFGX file saved before and

click OK.

(Y MOTOTRBO Network Interface Service Configuration Utility | = | = | 5 |

Configuration  View  Edit  Service  Help

ol " 0Oe

Select Configuration

CapacityMacgwcigx
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To set up the MNIS VRC gateway and talkgroups, click MNIS VRC gateway.

Settings | Rules | Activity | Metwork Configuration | Client List | Log I Export/Import Settings I Statistics|

=% Radio Server

% Licenses

¢ Radio Network Services

; | Add-on Modules

!:‘: Control Stations

H IP Site Connect Metworks
g Capacity Plus Systems
H Connect Plus

ﬁ Radio Activity Networls
g MNAI Systems

H SIP/RTP Interfaces

! B9 SmartPTT Radioservers

- g Capacity Max Metworks

{ E'h‘ Capacity Max 1
h- Trunking Cortroller

Bl MMIS Data Gateway

SR ¥ MNIS VRC Gateway
¢ L. ER Talkgroups

------ '-?, Security Settings

MHIS VRC Gateway

Mame MMIS VRC Gateway

Primany gateway address and port 172.16.1.13:6000
Redundant gateway address and port

Voice port {ocal) 40000 =

Listening to private calls between subscrbers

Phone calls

Note: The Voice transmission check box in the Capacity Max window should be selected. Otherwise, the

MNIS VRC Gateway parameter will not be shown.

Name: The name of the gateway.
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Primary gateway address and port: IP address and port of the main wice gateway. The IP address in this field

must match the value set in the corresponding fields in the Radio Management application (see the CMSS

Network:... settings in the Capacity Max Features menu of the CMSS Config configuration, the VRC Gateway

IP field in the General tab).

Radio Management EE
Configuration View » CMSS Config » CMSS Network » Network-1
Set Categories s
v E Configuration: CMS5 Config
v T Capacity Max Features Close
@ Capacity Max Systems: CapacityMaxSyst: General
@ Capacity Max Site Selection: CapMaxSysi
| (] CMSS Network: Network-1 £t | ~ General A
» Il MNIS -
CMSSIP | 1721619
CMSS UDP Port | 50000 3
Trunking Controller /P 172.16.1.10:50000
Presence Server [P 1721611050015
I VRC Gateway [P 17216113 I
System Advisor if 172.16.1.14
CMSS Internal Network | 182.168.231.0
4 I— .4 I I
Analyze Results(1%) |Tas|r5 | |Validation Results RUETG LT LALLM Search Results |Help
Connected To:LOCALHOST Radio Count1
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The port in this field must match the value set in the corresponding field in the Radio Management application (see

the MNIS Network:... settings in the MNIS menu of the CMSS Config configuration, the Server TCP Port in the

General tab).

Radio hManagement

G ]O

Configuration View » CMS5 Config » MNIS Network » MMNISNetwork-1

Set Categories 1

- E Configuration: CM55 Config
v Tl Capacity Max Features
@ Capacity Max Systems: CapacityMaxSyst:

Close

@ Capacity Max Site Selection: CapMaxSyst
(] CMSS Network: Network-1

General

~) General

v T MNIS ' 5
(7] MNIS Security: MNISSecurity-1 CAI Network |12 | &
(] MNIS System: MNISSystem-1 CAIl Group Network | 225 | 8
D MMNIS Advanced: MNISAdvanced-1 THS UDP Port |40{J? | g
| (] MINIS Network: MNISNetwork 1 £ | Telemetry UDP Port | 4008 | 8
D MNIS Forwarding Rules . rrva— - ]
Location Server UDP Port |40’01 | o
[| MNIS Application Override Rules —
_ e User Defined UDP Port 1 |0 - Dissbled | &

(] MNIS Sites: MNISSitesList-1 —
User Defined UDP Port 2 [0 - Disabled | &
User Defined UDP Port 3 [0 - Disabled | &3

KCMP High Efficiency Data Enable ||
XCMP Server UDP Port 4004
Battery Management UDP Port | 4009 | g
Control Interface TCP Part | 5000 | 8
| Server TCP Port | 6000 | gl 2

+ >

R ITER] [Tasks| |Validation Results [ L e e ] Search Results [Help

Connected To:LOCALHOST

Radic Count:1

Redundant gateway address and port: IP address and port of the redundant wice gateway. This field is

optional. If you fill in this field, ensure that the corresponding values are set in the Radio Management application.

Voice port (local): The port where the radioserver will expect wice data.

Listening to private calls between subscribers: Enables the Voice Recording feature, that allows the

dispatcher to hear private calls made from radio subscribers to other radio subscribers, dispatchers or telephone

subscribers and vice versa, read their messages.

Phone calls: Select this check box if you need the ability to make telephone calls.
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Create one or more talkgroups in accordance with the settings in the Radio Management application (see the

Capacity Max Systems settings, sorted by the Talkgroup Site Association value).

Settings | Rules | Activity | Network Configuration | Client Lt | Log | Bxport/import Settings | Statistics | Radio M =R
(=B Radio Server Control Station Talkgroups
2, Liosnses
5 Radio Network Services [ T ] Pacte
| Add-on Modules
. Cortrl Sfions ]
s P Site Cornect Networks Capacity Max System Server Data » Talkgroup Site As...
i Capacity Plus Systems [ ad ][ Remve | [ @ & Dovn ,
g Connect Plus Capacity Max Systems _ — _
g Radio Activiy Networks Name Site Number D ~ Wiewby: [ Subscriber Access Cantrol (8] Talkgroup Site Assaciation
g NAI Systems Al Cal Wid v OurSysteml
‘g SIP/RTP Intefaces o = * [ g
B SmatPTT Radiosevers AlCal- Site 1 1 v E
g Capacity Max Networs B} »
ﬁh Capaciy Max 1 Alcal- 52 2 2 nd Talkgroup D | Queue Priority | Allowed Sites J
. L“;"“'S‘"‘Dg C”g"‘“"e’ Group 100 L= 10 106 6 ~ Site Selection 1 -1
B ata Gateway Group 101 Wide v |1
g MNIS VRC Gateway W07 6 > Site Selection 1 -
B Taloroups | Group 102 Wide v |12
-, Secunty Settings Group 103 Wide vl 108 6 - Site Selection 1 -
Group 104 ide ~ e 109 6 ~ Site Selection -
Group 105 Wide ~ |15 110 6 ~ Site Selection 1 -
Group 106 s ~|106 1 6 ~  Site Selection 1 -
Group 107 Wid ~ |07
o =2 112 6 ~ Site Selection 1 -
Group 108 Wide ~ 108
13 6 ~  Site Selection 1 -
Group 103 Wide v 108
o 110 e ~l0 14 6 ~ Site Selection L - =
— v 103 items found (0 currently selected).
Analyze Results | | Tasks
Cannected To:LOCALHOST

Note: To open the Capacity Max System settings in the Radio Management application, click Actions >

Manage > Capacity Max System Server Data or press the Ctrl+Shift+G together.
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